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Introduction 
Congratulations on the purchase of your new F-900 Portable Ethylene Gas Analyzer. The F-900 

provides accurate real-time measurement of ethylene gas concentrations in a compact instrument 

suitable for field and laboratory use. At the core of the instrument is an electrochemical sensor that 

offers extraordinary sensitivity to ethylene, at levels as low as 0.04 ppm (40 ppb) in air. 

Ethylene production is known to increase in response to plant stress and during fruit ripening and 

maturity, and until recently, sensitive ethylene measurements were available only through 

elaborate and expensive gas sampling and gas chromatography analysis. The intent of the F-900’s 

portable design is to aid the research community in developing real-world ethylene management 

applications for the benefit of growers, processors, and consumers.  

The F-900 analyzes the concentration of ethylene in a gas sample for the purpose of research or 

ethylene management. The F-900 employs electro-chemical sensors as well as several other 

sensors for temperature, humidity, GPS location, and optionally carbon dioxide (CO2: high and low 

range) and oxygen (O2). During a sample, the subject gas travels across the surface of the electrode 

and diffuses into the electrochemical cell where ethylene is oxidized. The current created by the 

oxidation is measured and interpreted as the concentration of ethylene (reported in parts per 

million or ppm).  

We hope you enjoy using your F-900 Portable Ethylene Gas Analyzer. 

 

Figure 1: The F-900 Portable Ethylene Analyzer front panel and display. 
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Features 

 High sensitivity to C2H4 (0 ppm – 200 ppm)  

 CO2 and O2 sensing capability (optional) 

 Compact portable form factor (2.43 kg) 

 Real time continuous monitoring 

 Internal data logging and storage (4 GB SD card included) 

 Automatic data logging with adjustable interval 

 User adjustable flow rate 

 Transflective display enables easy viewing in direct sunlight 

 Rechargeable Li-Ion battery provides 4 hours of monitoring in the field 

 Multiple configurations to accommodate in situ research and controlled atmosphere 
monitoring  

 Instantaneous and accumulated measurement modes (Monitor and Graph View) 

 Quick connect sampling ports 

 Data saves in .csv (commas separated value) file 

 Configured for domestic and international operation: 110 VAC, 60 Hz or 230 VAC, 50 Hz 

 Non-destructive measurements 

 Mini-USB chargeable and mini-USB data download 

 Time-date stamped data records 

 External wire terminals for fixed location monitoring or control applications 

 GC Emulation Mode for small sample volumes ranging 0.8 – 20 ppm C2H4 (optional) 

 

 
Figure 2: The removable SD card on the F-900 makes data transfer quick and simple. 



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 3 
sales@felixinstruments.com                                         www.felixinstruments.com 

Specifications 
 

F-900 Specifications 
Display Sunlight visible transflective graphic LCD 

Operating environment 0°C - 45°C (0-90% humidity non-condensing) 

Battery Capacity 4 hours - Rechargeable Li-Ion (5000 mAh) 

Dimensions 183.5 mm x 111 mm x 120 mm 

Weight 2.43 kg 

Enclosure Anodized aluminum 

Air Sampling Rate 0.2 Liters/minute 

Sample Rate 
Open Loop - Monitoring @ 5 sec intervals 
Closed loop < 3 min 

Warm-up time <5 minutes 

  

C2H4 PPB Sensor  Electrochemical 

Nominal Range 0- 2 ppm 

Resolution 0.001 ppm 

Lower Detection Limit 0.04 ppm (40 ppb) 

Accuracy ±10 %; adjusted for temperature and humidity 

Offset Recalibration Daily 

Span Recalibration Weekly (calibration gas required) 

  

C2H4 PPM Sensor Electrochemical 

Nominal Range 0- 200 ppm 

Resolution 0.1 ppm 

Lower Detection Limit 0.5 ppm  

Accuracy ±5 %; adjusted for temperature and humidity 

Offset Recalibration Bi-annually 

Span Recalibration Bi-annually (calibration gas required) 
 

GC Emulation Mode Specifications 
C2H4 Range 0.8-20 ppm 

Accuracy ±10 % 

Minimum Sample Volume 15 cc 
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Optional Sensors 
CO2 PPM Sensor  Low-Power Non-Dispersive Infrared Gas Analyzer 

Chopping Frequency 1Hz 

Source Life 5000 Hours 

Nominal Range 1 – 2000 ppm (Standard) 

  0 – 3000 ppm (Optional) 

Zero Scale Resolution 0.1 ppm 

Full Scale Resolution 1 ppm 

Repeatability ±0.1 ppm (short term) 

Accuracy < ±2% up to 3000 ppm 

Sample Cell 100 mm x 10.2 mm (3.94" x 0.4" diameter) 

Warm-up time <3 minutes 

Weight 172.6 g 

Offset Recalibration Daily 

Span Recalibration Bi-annually (calibration gas required) 

  

CO2 Percent Sensor  Infrared Sensor, Pyroelectric detector 

Nominal Range 0 – 20% (200,000 ppm)    (optional: 0-5%) 

Full scale resolution   0.01% 

Zero repeatability  ±10 ppm 

Full scale Repeatability ±500 ppm 

Accuracy 1.5% of Full Scale  

Lifetime  >5 years 

Warm-up time <3 minutes 

Weight 7 g 

  

O2 Percent Sensor  Electrochemical 

Nominal Range 0-100% 

Resolution 0.1% 

Operating environment 0°C - 55°C (5-95% humidity non-condensing) 

Weight 7 g 
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Warnings 
 Read this manual carefully before using: this manual should be read by anyone who will be 

operating the F-900. 

 By following the guidelines, the F-900 will function according to the specifications in this 

instruction manual.  

 All repairs should be performed by a Felix Instruments technician. 

 The analyzer must be used to measure the rate of ethylene in the presence of nitrogen, 

oxygen and carbon dioxide. All other gases in high concentration could lead to erroneous 

measurements, or the destruction of the sensor. Do not use the instrument in the presence 

high concentrations of aromatic solvents, hydrocarbons or other volatile organic 

compounds, such as in unventilated painting rooms or chemical storage rooms.  

 Damage to the analyzer can occur if the fluid reservoir level is too low or if the inlet and 

outlet gas connections are blocked while the pump operates. This can cause false readings 

or irreparable damage to the sensor.  

 If smoke comes out of the analyzer, turn off the power immediately and contact Felix 

Instruments-Applied Food Science. 

 Keep the analyzer in a clean and ventilated room at ambient temperature.  

 Do not allow fluid to aspirate in the analyzer, which can destroy the sensors. 

 Do not use the F-900 in a high RF (radio frequency) environment. High RF will disrupt 

the F-900.  

 ESD (electrostatic discharge) interferes with the F-900 measurement data. 

 Do not tilt the F-900 when Chamber In contains water! 

 WARNING: Do not store the F-900 without charged batteries! The internal batteries 

must have charge to maintain the accuracy of the sensors, even when the unit is 

powered off. It is recommend to keep the instrument connected to the power supply 

for long term storage.    

 

The analyzer has a reservoir containing 1 mol of sulfuric acid (2N H2SO4). Avoid 

contact with skin and eyes. If contact occurs, rinse thoroughly with water or use 

an eyewash or safety shower. Do not drink the contents of the fluid reservoirs as 

it could cause chemical burns. See Appendix I for the safety data sheet and 

further information on sulfuric acid.  
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Theory of Operation 
The ethylene sensors in the F-900 are electrochemical. With this type of sensor, the gas sample 

travels across the surface of the electrode and diffuses into the electrochemical where ethylene is 

oxidized. The current created by the oxidation is measured and converted to parts per million 

(ppm) of ethylene.  

 

 

 

 

 

 

 

 

 

Figure 3: Diagram of an electrochemical sensor. (A) working electrode (R) reference 

electrode (C) counter electrode (E) electrolyte. Image credit: doi:10.1093/aob/mcs259. 

 

The F-900 flow rate is regulated by a pump and a flow meter. Additional optional sensors are 

enabled/disabled in the Setup Menu (see page 41), as well as “conditioning chambers” on the back 

of the instrument (see page 54).  

The temperature and relative humidity sensors are located inside the instrument. Therefore, the 

temperature sensor is subject to heating by the F-900 internal electronics. The temperature reading 

is often 4-5OC above ambient and in turn, relative humidity readings are affected. The use of water 

in Chamber In (PolarCept, see page 8), will also affect relative humidity readings.  
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Figure 4: Flow path diagram of the F-900 ethylene analyzer. Dashed line indicates optional 

flow path capabilities.  

 

Interfering Gases 
No analytical method is completely specific. Gases present in the environment, other than the 

“target” gas of a measurement, may affect instrument response. Interferences are not necessarily 

linear, and may also exhibit time dependent characteristics. 

The following table details the approximate concentration in parts per million of interfering gas 

required to cause a 1 ppm detection in the ethylene analyzer. Please note that the response values 

given are not absolute.  
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Table 1: Interfering Gas and the F-900 sensor 

 

 

Ripening fruit emit a complex mixture of hydrocarbons, including ethylene. Oxidation of these other 

gases in the electrochemical sensor cannot be readily distinguished from ethylene. This causes the 

ethylene value to be falsely high in the presence of interfering gas. Felix Instruments has tested a 

method to absorb some of the competing gases and provide better ethylene measurements. This 

method, PolarCept, uses distilled water in conditioning Chamber In and has been shown to filter out 

alcohols and produce less interference.  

 

PolarCept 
PolarCept is the use of distilled water in conditioning Chamber In to filter out or trap some of the 

interfering gases. Gas from the sample environment is passed through the water trap. Some of the 

polar molecules are held in the trap, while ethylene passes through the water trap to the sensor, 

where oxidation occurs. CO2 is released as the oxidation product from the sensor. The water being 

used can become saturated after several minutes, so it must be cleaned of the trapped interfering 

gas molecules. Trapped interfering gases are driven out of the water during the cleaning time by a 

concentration gradient.  

It is recommended to always use the PolarCept filter when measuring a gas mixture or 

interfering gases present will be reported by the instrument.  
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PolarCept: Measure 

 

 

 

 

Regeneration: cleans the waeter 

 

PolarCept: Clean 

 

 

 

 

 

 

 

 

 

Figure 5: Top: diagram of measure period during use of PolarCept. Bottom: diagram of 

cleaning period of PolarCept.  
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Unpacking the F-900  
The F-900 base unit arrives with the F-900, strap and several accessory parts to use with the 

instrument. Included are the heavy duty USB cable, charger, tubing accessory kit, potassium 

permanganate (KMnO4) and an F-900 Instruction Manual. Several different styles of connector 

pieces and various lengths of tubing that do not outgas (ex: Viton or Teflon) are provided as part 

of the tubing accessory kit. Male and female quick connectors can be added to tubing and used to 

connect sample bags or custom chambers to the F-900.  

 
Figure 6: Accessories and parts that arrive with the F-900, clockwise from top center: F-900 

ethylene analyzer, power supply and heavy duty USB cable, Viton tubing, Teflon tubing with 

quick connects, GC Emulation port, assorted quick connects, GC Emulation sampling 

syringe, Silica gel in conditioning chamber with lid. 

 

The F-900 includes the consumable potassium permanganate (KMnO4), which is used to scrub 

ethylene and other hydrocarbons from the gas stream. If the instrument has an optional CO2 sensor, 

soda lime is included, which is used to scrub carbon dioxide from the gas stream and to create a 0 

ppm CO2 gas for the CO2 zero calibration.  
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F-900 Research Kit Accessories 
The F-900 Research Kit (F-900RK) includes parts to non-destructively sample fruit in the field or 

laboratory. The F-900RK arrives in a hard-sided carrying case with a fruit chamber and wand with 

flexible tubing to sample fruit or plants. The fruit chamber includes a closed chamber lid and a lid 

with a seal to allow sampling of fruit still intact on the plant. The F-900RK includes all the parts and 

accessories that arrive with the F-900, as well as an external conditioning tube, sample bag, 

injection port assembly, glass syringe, needle, and a jar of silica gel which can be used to dehumidify 

the gas.  

 

Figure 7: The F-900RK arrives with a fruit chamber and two lids: closed chamber lid (left) 

and slit chamber lid (right).  
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Operating Instructions 
To turn the instrument on, press the green power button. The top of the display reads F-900 and 

the current firmware version the unit is running. For information on the latest firmware version, 

please visit the F-900 software webpage (http://felixinstruments.com/support/f-900-support). 

The line underneath this states “Felix Instruments”. Below this, a menu will appear on the display 

with the following options: Measure, Setup, View and File. This is the F-900 Main Menu. After the 

instrument is powered on, the uptime and battery life remaining will be displayed on the bottom 

line. The uptime, or time the instrument has been powered on, is displayed in hours: minutes, 

followed by the battery life in percent. 

Note: If the F-900 does not power on, eject the SD card or disconnect the mini-USB cable from the 

front of the instrument. Then, power the F-900 on. Re-insert the SD card or reconnect the charger. 

 
Figure 8: The options on the Main Menu of the F-900. 

 

From the Main Menu, there are four menu options: Measure, Setup, View and File. Use the up and 

down arrows to switch between menu options and the right arrow to select. Press the green power 

button to power off the F-900. 

 

Note: To force a power off and reset of the F-900 at any point, press and hold the power button 

for 10 seconds. This “emergency hard shut-down” feature exists to address hardware or software 

problems and should not be used except when needed.  

http://felixinstruments.com/support/f-900-support
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Charging the Internal Battery 
The F-900 arrives with a wall charger that can be used to recharge the F-900 battery, as well as for 

continually powering the unit during long-term monitoring. To charge the F-900: 

 Connect the mini-USB cable to the front panel of the F-900 

 Plug the charger into the wall 

 Check the charge status (on/off) at the “View>Battery” menu 

 

Figure 9: The battery charger setup of the F-900. 
 

The display will flash “powering off” on the top line when you hit the power key. “Power Off” will 

flash on the display as the instrument is powered off. For fastest charging of the F-900, use the 

highest rated port on the charger and do not connect any other USB devices to the charger.  

To use the F-900 in Monitor Mode to continuously monitor fruit storage rooms or other locations, 

or to run the instrument for days or weeks at a time, connect the mini-USB cable to the charger 

cable and to the connection port on the front panel. Plug the charger into an electricity source.  

WARNING: Do not store the F-900 without charged batteries! The internal batteries must 

have charge to maintain the accuracy of the sensors, even when the unit is powered off. It is 

recommend to keep the instrument connected to the power supply for long term storage.    
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F-900 CO2 PPM Sensor and Battery Power 

The CO2 PPM sensor draws a lot of power; if trying to conserve battery life, the sensor should be 

turned off when not being used. The CO2 PPM sensor will draw power when turned on, even if the 

F-900 is not actively measuring.  

 Always turn the CO2 PPM sensor to “off” for the fastest recharge, either using the mini-USB 
cable and computer or with a wall charger.  

 The CO2 PPM sensor ranges from 0-2000 ppm. The CO2 PCT sensor is from 0-20% and does 
not have the same power draw.  

 

To turn off/on the CO2 PPM sensor: 

1. Go to Setup>Sensor>Sensor Selection. 

2. When asked “Are you sure you want to continue?” press Enter. 

3. Press the down arrow to highlight CO2 PPM. 

4. Press the right arrow key to highlight On/Off.  

5. Press the up/down arrow key to toggle On/Off the sensor. 

6. Press Save when the desired setting is highlighted. This will turn off the CO2 sensor until 

you come back to this menu and turn it back on. 

7. If you press Enter, the CO2 sensor setting will only be temporarily saved. When the 

instrument is turned off and then back on, the CO2 sensor will be enabled.  

 

 

  

Setup Sensor 

 

C2H4 PPB          On 

C2H4 PPM         On 

CO2 PPM            Off 

CO2 PCT             Off 

O2                        Off 
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Measure Menu: Taking a Measurement 
To begin taking measurements, select the Measure Menu by pressing the right arrow when 

Measure is highlighted on the Main Menu display. Make sure the IN and OUT ports on the front 

panel of the instrument are clear from any obstructions. Create and open a file before starting a 

measurement, otherwise the default filename on the SD card is File01.  

If sampling ambient air, turn the unit on and leave the front ports free of obstruction. If sampling a 

container or pallet, connect the Viton tubing to the “In” port and place the end of the tubing into the 

container or pallet to be sampled. If using the F-900RK, place the fruit to be sampled in the fruit 

chamber, and connect it to the IN port on the unit. It is up to the specific setup whether the OUT 

tubing is connected to the OUT port with Chamber Out filled with potassium permanganate 

(KMnO4) and set to “on”. If left disconnected from the OUT port, the fruit chamber is allowed to 

replenish with ambient air.  

Sensor Stability 
The F-900 will begin to warm-up. The F-900 will display the “Sensor Stability” screen after pressing 

the RIGHT arrow to get into the Measure Menu. The display will show the File that is open and the 

Flow of gas being pumped through the instrument. Below this will be whether the initialization is 

automatic or manual. If the initialization is automatic, the F-900 will precede directly to the 

measurement (Graph Mode) once the sensors have stabilized. If the initialization is manual, 

Monitor Mode will not be triggered until the user presses the right arrow to enter Monitor Mode.  

 Press the down arrow key to switch between automatic and manual initialization.  

 Press the right arrow to skip the Sensor Stability screen and proceed to the Graph Mode 

display.  

If the offset autocorrection feature is enabled, then the unit will run the set zero process 

automatically every 24 hours (or at the user defined time interval). The offset autocorrection 

utilizes Chamber Out, which should be left full of KMnO4 even if Chamber Out is set to “off” during 

normal measurements. For more details on the offset autocorrection, see the Setup>Calibration 

menu on page 44.  

 

NOTE: The F-900 ethylene analyzer sensors should be given 24 hours to stabilize after being on an 

airplane. Start a measurement and enable the Closed Loop (On). Then, allow the instrument to 

measure for 24 hours while connected to a power supply.  
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Graph Mode 
Graph Mode will be entered automatically when the unit has stabilized in Sensor Stability mode. Or 

to enter Graph Mode, press the right arrow when the F-900 is at the Sensor Stability screen. This 

view graphically displays the measured C2H4 value over time. To switch Graph Mode into Monitor 

Mode, press the right arrow. To exit the measurement, press Stop. 

 

Figure 10: Graph Mode with red arrow indicating direction of movement. 

Directly below the graph is the current ethylene value. Above the graph is the dynamic range (on 

the left it is 1.000 ppm, on the right it is 2.000 ppm). The y-axis scale is set by the highest value 

shown in the buffer. This range will scale vertically, dependent on the highest concentration of 

ethylene measured. If the concentration is small, the dynamic range will reflect this. For example, 

the initial value was 0.162 ppm and there is a sudden peak to 7.578 ppm. As the spike or peak 

occurs, the graph will scale to 10.000 ppm. If the sample returns to 0.168 ppm, the scale will remain 

at 10.000 ppm until the graph and the buffer are cleared.   

The scale of the graph can be increased or decreased by using the up and down arrows. Pressing the 

up arrow will zoom in on the data, minimizing the visible range. Using the down key will increase 

the scale, up to 200 ppm. Note that the minimum range of data visible (down to 0.150 ppm) 

depends on the current data being graphed. For example, if the current data is 3.486 ppm, the user 

may use the up key to zoom in to the 5 ppm range, but cannot zoom in to a narrower 2 ppm range. 

The graph begins on the left side and moves with the vertical line towards the right as more data 

points are added. Once the time line reaches the right side of the display, the data will be 

compressed to the far left.  

The time scale relates directly to the vertical position line. In other words, the line moves to the 

right as new data points are added. Every time a data point is added, the time scale is incremented. 

For time under 10 minutes, the graph is updating almost every second. The bottom of the display 

shows the uptime of the F-900 and current battery level.  
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Monitor Mode 
The large bold value on the top line is the digitally filtered value of the raw ethylene 

measurements. Next, the relative humidity in percent, of the gas stream in the instrument is 

displayed followed by the temperature in degrees Celsius. The atmospheric pressure, is displayed. 

Press the down arrow to view the flow rate in milliliters per minute. The default flow rate is 200 

mL per minute. If the unit has a high resolution CO2 sensor on board, the CO2 value in ppm will be 

displayed below the ethylene value. If the unit has a low resolution CO2 sensor, or O2 sensor on 

board, the value will be displayed in percentage (%).  

 

 

 

 

 

 

 

 If Autosave is enabled, “saved” will flash at the top of the display each time the data is 

automatically saved to the file.  

 Press the Stop key to stop the measurement and exit to the Sensor Status display. 

 Press the left arrow to enter Graph Mode.  

 Press the right arrow to get to the Measurement Settings menu. 

 

The temperature and relative humidity sensors are located inside the instrument. Therefore, the 

temperature sensor is subject to heating by the F-900 internal electronics. The temperature 

reading is often 4-5OC above ambient and in turn, relative humidity readings are affected. 

The use of water in Chamber In (PolarCept, see page 8), will also affect relative humidity 

readings.  

The detection rate (Det. Rate) in nmol/second is calculated by the following formula, based on 

ethylene being an ideal gas.  

 Detection rate (n’) = (V*P)/(R*T).  

 Where volume (V)= flow rate * concentration (L/s)*(ppb) = nL/s  

 P = pressure (atm) = (kPa)*0.0098692 

 R= constant = 0.0821 

 T = absolute t (K) 

  

MONITOR       

3.26 ppm 
 

Humidity                           47.0% 
Temperature                     28.7C 
Pressure                     101.0 kPa 
Flow                                 200 mL 
Det Rate                 0.03 nmol/s 

 
Uptime 01:17   Bat 95% 
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The detection rate starts calculating the ethylene emission rate from the fruit. Emission rate is 

typically calculated with the following parameters and the weight of the fruit. 

 Flow rate: 0.2L/min = 15.0L/hr 

 Sensitivity to C2H4: 0.1 µL/L or 100 nL/L 

Therefore, the F-900 optimally detects around 1500 nL/hr. If the specimen weighs 50 grams, then 

the emission rate is: 30 nL C2H4/gfw/h. The unit is nanoliters of ethylene per gram fresh weight per 

hour.  

 

Measurement Settings 

The Settings screen is accessed by using the right arrow from Monitor Mode, and provides a short 

list of variables which may be manipulated while measurements are being made. The exterior 

Conditioning Chambers are turned On/Off, valves are closed causing gas to circulate internally 

(Closed Loop On/Off), or the ethylene zero calibration (Set Zero) can be initiated. Chamber Out is 

primarily used with potassium permanganate (KMnO4) for cleaning water and setting the 

instrument’s offset. Changes cannot be made to the settings menu if the F-900 is “correcting offset”. 

If the measurement is setup for PolarCept (Setup > Chamber > Chamber In = Special) then Chamber 

In cannot be turned on/off from the Measure > Settings menu.  The measurement must be stopped 

and default Setup Menu parameters changed. It is recommended to use Chamber In with 

distilled water for most ethylene measurements.  

The Set Zero procedure begins by automatically closing the IN and OUT port valves on the front of 

the instrument (Closed Loop) and enabling Chamber Out (On) with KMnO4. The instrument will 

continue to record data to the file, with the mode listed as “offset”. The instrument will allow time 

for ethylene to be scrubbed from the internal environment, wait for a stable point to be reached, 

and then set a new zero calibration point. Stability is reached when there is no more than a 40 ppb 

change in ethylene for 10 minutes. The limit of 40 ppb is the same as the noise. The set zero process 

takes about 25 minutes to complete. 

The ethylene sensor zero calibration should be performed every 24 hours to compensate for 

daily baseline drift. To perform the C2H4 Set Zero:  

1. Place potassium permanganate (KMnO4) in Chamber Out. 
2. Power on the instrument and allow adequate warm-up time (3 min). 
3. Press the right arrow when Measure is highlighted to begin a measurement. 
4. Let the sensor stabilize and automatically begin measuring. 
5. Once the measurement begins, press the right arrow until you access the “Settings” menu.   
6. Scroll down to “Set Zero”. 
7. Press the right arrow to highlight “C2H4”. 
8. Press Enter.  
9. A message appears asking “zero selected sensors?” 

a. Press Enter to confirm.  
10. A message appears asking to “Place KMnO4 in CH_Out.’” 

a. If KMnO4 is in Chamber Out, press Enter to confirm. 
11. The display will switch to Monitor Mode and “correcting offset” is shown at the bottom. 
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a. The settings will automatically change to turn on Chamber Out, turn off Chamber In 
and turn on the Closed Loop.  

12. The instrument will wait until no more than a 40 ppb change is detected for 10 minutes 
before setting the zero calibration point.  

13. The instrument will make a “beep” sound twice to indicate that the offset correction is 
complete and “correcting offset” will no longer appear on the display. The entire set zero 
process takes about 25 minutes.  

14. The measurement will continue with the original settings for the conditioning chambers 
and Closed Loop on/off. 
 

 

 

 

 

 

 

 

 

 

Figure 11: Measurement > Settings Menu display (left); flow path of internal gas stream 

(right). 

Electrochemical Sensor Response 

The lag in sensor response is a natural phenomenon for charged porous membrane electrodes. The 

platinum electrode can be thought of as a series of cylindrical pores. Each of these pores will have a 

double layer in the radial direction. The interactions between the molecules, convection from air 

movement, electric fields and the concentration gradient result in a lag following a change in 

concentration1. Additionally, a lag is created due to the volume of internal tubing the instrument 

contains. Because of the volume of internal tubing, it takes about 120 seconds to see a response by 

the sensor.  

                                                             
 

 

 

11 Kontturi et al., “Ionic Transport Processes: In Electrochemistry and Membrane Science.” (Oxford University 
Pess) 2008 

SETTINGS 

 

Chamber OUT                 On 
Chamber IN                    Off 
Closed Loop                    On 
Set zeros                    C2H4 
 

Uptime 01:15 Bat 75% 
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Auto-Escape Feature 

An upper limit auto-escape feature acts as a safety feature of the unit. This safety feature is always 

on. If the sensor detects over 200 ppm ethylene, the F-900 will auto-escape from Monitor Mode to 

prevent poisoning of the electrode. This will stop the measurement. If the sensor becomes 

poisoned, it will continually auto-escape with the error message "sensor out of bounds". If this 

happens, use potassium permanganate (KMnO4) in Chamber Out and set the instrument to Closed 

Loop. This will begin to clean the gas inside the instrument. If possible, the F-900 ethylene analyzer 

should be removed from the high concentration environment.  

 

Flow Block Error 

The display may show “flow blocked” and a very low flow rate (less than 40 ml/min) for several 

reasons. If this message appears on the display of the F-900, ensure that the intake on the front of 

the F-900 is free from obstruction and not covered. If connected to tubing or a fruit chamber, 

disconnect and reconnect the tubing from the IN port.  

If using water in Chamber In, remove the top panel of the F-900 and ensure no water has entered 

the F-900. There is a white hydrophobic filter directly down the flow path Chamber In to be 

checked for water, as well as a hydrophobic filter near the in port on the front of the F-900. If water 

is found inside the tubing or filters, Stop the measurement and allow the instrument to dry out. Be 

careful no further water damage occurs when turning the pump back on. 

 

No SD card Present 

If the autosave is enabled and no SD card is present, the user will be notified by seeing “INSERT SD 

CARD OR HIT ENTER KEY”. After enter is pressed, “NO SD CARD” is visible on the Sensor Status 

display where the FILE and filename usually are. Pressing any other button besides Enter, will 

return to the main menu. Each time the F-900 tries to autosave, the unit will flash “write error” 

instead of “saved” at the top of the display.  

 

F-900RK: Using the Research Kit Fruit Chamber 
To use the F-900 Research Kit in the field or laboratory, attach a hose of the chamber wand to the 

IN port on the front panel. Slide the end of the wand into the chamber and tighten the thumb-screw. 

Make sure the connection is snug. The fans inside the chamber will begin to spin when the 

connection is established. The fruit chamber available is 2L in volume. The chamber either has a 

flat-bottom or a bottom-slit to allow for non-destructive sampling. A fruit stem or petiole that is 

attached to the plant is passed through the slit and then closed in the chamber. This allows C2H4 

levels to be recorded during ripening without damaging the fruit. Leaf chambers available for the 

CI-340 Photosynthesis System, from CID Bio-Science, Inc. are compatible and interchangeable with 

the F-900 Research Kit.  
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If the tube is not connected to the OUT port, ambient air will be used to replenish the fruit chamber.  

 

If the gas returning to the fruit chamber needs to be conditioned, consumables should be placed in 

Chamber Out and it should be turned on. Possible reasons to condition the air returning to the fruit 

chamber include scrubbing humidity (with silica gel) or scrubbing CO2 (with soda lime). Build-up of 

carbon dioxide may inhibit fruit respiration at high concentrations. At high concentrations, the 

sensor fails to consume all the ethylene, so KMnO4 could be used to scrub ethylene and not return it 

to the sample system.  

 

Figure 12: Using conditioned air to replenish the fruit chamber by connecting the IN and the 

OUT (left); using ambient air to replenish the fruit chamber by disconnecting the OUT 

(right). 

 

To sample a fruit: 

 Open a data file to save the measurements to. 

 Attach the chamber to the F-900 by screwing on the wand to the top of the chamber. 

 Next, connect one of the tubes from the wand to the Intake port on the front of the F-900. 

 Connect the black power chamber cable to the left of the display to power the fans in the 

fruit chamber. 

 Place the fruit inside the chamber and close it. 

 Observe and record the rate of change of ethylene over time with the F-900 Monitor Mode.  
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GC Emulation Mode  
To use the F-900 to analyze a small sample in a syringe, the GC Emulation Mode should be used. 
With the simple addition of our inline injection port, small volumes of analyte can be accurately 
measured. The use of GC Emulation Mode requires an ethylene standard gas, in the same 
concentration range of the sample to be measured.  

In addition to ethylene, GC Emulation Mode measurement data is available for the optional sensors 
for CO2 and O2. Calibration standard gas is not required for CO2 or O2 in this mode, only for ethylene. 
Simultaneous results can be collected for all enabled sensors.  

There are several improvements compared to a Gas Chromatograph (GC): 

 No need for N2, H2, or bottled air. Ethylene standard gas is required.  
 Portable. 
 No heating or oven required. 
 Predicts ethylene concentration without chromatography. 

 

Figure 13: GC Emulation port connected to front of instrument for small volume samples.  
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How GC Emulation Mode Works 

The GC Emulation Mode employs a patent pending Flow Inject Analysis method that integrates the 
signal from the ethylene sensor for 210 seconds to determine ethylene concentrations ranging 
from 0.8-20 ppmv with minimum sample volume of 15ml (larger sample volumes, such as 50 
ml, will provide greater accuracy). The resulting value is then compared against a user-definable 
calibration point and an estimated concentration is determined. As shown by Equation 1 below, the 
injection volume is determined by the expected concentration of ethylene and the detection limits 
of the sensor. If interfering gases are expected, their expected concentrations must be subtracted 
from the reported ethylene concentration.  

 

Equation 1:  0.8 𝑝𝑝𝑚𝑣 ≤
𝐼𝑛𝑗𝑒𝑐𝑡𝑖𝑜𝑛 𝑉𝑜𝑙𝑢𝑚𝑒∗𝐸𝑥𝑝𝑒𝑐𝑡𝑒𝑑 𝐸𝑡ℎ𝑦𝑙𝑒𝑛𝑒 𝐶𝑜𝑛𝑐𝑒𝑛𝑡𝑟𝑎𝑡𝑖𝑜𝑛

60𝑚𝐿
≤ 20 𝑝𝑝𝑚𝑣 

Exceeding the lower limit of Equation 1 will decrease the accuracy and precision of the result. 
Exceeding the upper limit will affect the sensitivity of the instrument and will cause the 
instrument to under-estimate measurements for up to 24 hours. A new calibration point may 
be required. 

Using GC Emulation Mode requires the use of standard ethylene gas. Each injection should be 
done by the same technician, as human technique will alter the result. Setting the calibration 
point near the expected ethylene concentration will provide the most accurate estimation. 
Ethylene standard of 1.5 ppm is commonly used for GC Emulation Mode.  

 
GC Emulation Mode Tips 

 If the expected sample’s C2H4 concentration is > 2 ppm, use a higher flow rate to increase 

signal detection. Recommended flow rate is 250 mL/minute, and can be set in Setup>Flow 

menu. 

 In general, higher injection volume will also increase signal detection (ex: 50 ml). 

Recommended minimum injection volume is 15 ml. Once injection volume is set, please 

make sure to maintain the same volume of injection throughout all measurements.  

 The F-900 requires about 10 minutes of warm-up time when using GC Emulation Mode, 

especially for the CO2 PPM sensor.  
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 If the injection port does not have a pressure-release valve, please disconnect and reconnect 

port at end of each measurement (when “Results” displayed) to prevent pressure build-up. 

The pressure release valve is circled in red in the figure below.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 14: GC Emulation injection port pressure-release valve, circled in red.  
 
When using GC Emulation Mode, the protocol is to perform 3 injections per sample, which takes 

approximately 12 minutes total (3.5 min per injection): 

1. Calibration injection 

2. Verification injection (using same calibration gas) 

3. Sample injection 

It is recommended to verify your calibration point after it is set. Inject the same calibration gas 

and compare the displayed result with the calibration concentration. Reset the calibration point if 

needed. For example, if the calibration point is 5.0 ppm and your verifying sample reads 5.9 ppm, 

reset the calibration point by pressing Enter. The acceptable range (±10%) would be 4.5-5.5 ppm. 

Repeat calibration/verification injections until samples are reported consistently. 

 

Note: Injection mode standard error (at two sigma) is ±10% of calibration concentration. 

 
  

C2H4: 5.9 ppm 
Set as Calibration? 

Yes: Enter, No: Stop 



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 25 
sales@felixinstruments.com                                         www.felixinstruments.com 

GC Emulation Mode Operation Procedure 

Section 1: Warm up 

1. Turn on GC Emulation Mode in the Setup>Measure menu. Press Save to save changes and 
exit to the main menu.  
 

 

 

2. Enter the measure menu and wait for the instrument to stabilize. To skip the stabilization, 
press the right arrow.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Follow the instructions on the display and connect the inline injection port. Press Enter.  
 
 
 
 
 
 
 

4. Enable or disable the Water Chamber (PolarCept) to increase selectivity of C2H4 

measurement. Enable the chamber only if CO2 and O2 measurements are NOT involved. 

Chamber In should be filled with fresh distilled water to the fill line on the back of the F-

900. The distilled water in Chamber In should be replaced with fresh DI water every 10 

injections. Alternatively, Monitor Mode can be used to clean the water.  

 

SENSOR STABILITY 

File   file01 

Flow   200 mL 

Initialization  Automatic 

Environment Stabilizing 
Please Wait...42% 

Uptime 00:11 Bat 98% 

Setup injection tube 

then press Enter 

Uptime 00:13 Bat 98% 

Setup          Measure 

Mode                              GC Emulation  

Use Water Chamber? 

(C2H4 only) 

Yes: Enter, No: Stop 
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5. Wait 10 minutes (600 sec) for the environment to stabilize. When using GC Emulation 
Mode, the F-900 sensors require a warm up of 10 minutes. Proper warm-up is especially 
important for the CO2 sensors. If already warmed-up, press Enter to skip and continue to 
the next step.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Section 2: Calibration Injection 

6. Enter the volume of sample gas that will be injected in cc (1 ml = 1 cc). Recommended 
minimum sample volume is 15 ml. Press Save. 

 

 

 

 

7. Inject calibration gas, then press Enter. When injecting gas, bend the GC Emulation port 

downwards and keep the glass syringe horizontal (see following figure). This will prevent 

the heavy glass plunger from accidently pressing out gas before being ready. For larger 

samples, a larger syringe must be used (ex: 60 ml) with a non-coring needle. The sample 

must be injected all at once (do not inject three separate 20 ml samples for a 60 ml volume). 

After pressing Enter, remove the syringe from injection port. 

 
 
 
 
 
 
 
 
 
 
 

Initial count                             1609543 
current count                          1609383 
peak count                               1609616 
CO2                                                0.03% 
O2                                                   20.6% 
 
 Processing…210 

Uptime 00:40    Bat 90% 
 

Stabilizing environment 

Enter Skip 

C2H4                   484ppm 
CO2                         0.03% 
O2                            20.6% 
Humidity                51.3% 
Temperature         21.4C 
Flow                       202mL 
 
Ready in 600 sec 
 
Uptime 00:45  Bat 92% 

Setup gas 
Then press Save 

Volume                          000015cc 
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Figure 15: Example of proper injection technique for GC Emulation Mode. 
 
 

8. Wait for processing countdown to complete from 210 seconds. 

9. Set the sample as your calibration standard by pressing Enter for “Yes” when asked “set as 
calibration”? 

10. Enter the concentration of the calibration gas in ppb (1 ppm = 1000 ppb). The concentration 
of the calibration gas is printed on a tag or sticker on the bottle of gas (example: 1.555 
ppm). Press Save to see ethylene value in ppm on display. 

 

 

 

 
 
 
 
 
 
 

Results 
Enter: Repeat   Stop: Done 
peak count             2729747 

2.00ppm 

CO2                               0.03% 
O2                                  21.1% 

 
Uptime  00:52   Bat 90% 
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Section 3: Verification Injection 

11. Press Enter to repeat and inject a verification of the calibration gas (or press Stop to exit to 
main menu.) 

a. There is a “cleaning” time between samples, which can be skipped by pressing 
Enter. During cleaning, the ethylene sensor is consuming the ethylene from the 
sample. The instrument will wait until the ethylene signal is less than 100 ppb 
before finishing the cleaning. Cleaning will take longer with high concentration 
samples.  

b. If measuring CO2 with GC Emulation Mode, the unit will clean or flush out the 
internal volume between samples, as indicated on the display.  

Note: If injection port does not have a pressure-release valve on the OUT side, briefly 
remove and replace the injection port from the F-900 to manually release the internal 
pressure build-up between injections.  

12. Follow the same steps as above, fill the syringe with the same volume (ex: 15 ml) of 
ethylene calibration gas. This time at step #9, choose “No” by pressing Stop when asked 
“Set as calibration?” to view the ethylene concentration on the display. 

13. When the results of the verification injection are displayed, only continue to the sample 
injection if the verification is within 10% of the calibration concentration. If it does not 
verify, start over with a new calibration injection.  

 

Section 4: Sample Injection 

14. Follow the same steps as for the verification injection, and inject the sample gas using the 
same volume of sample as for calibration and verification injections. If removing sample gas 
from a sample bag, it can be helpful to hold the plunger of the syringe to reduce the 
possibility of sample being pushed out before injection. Holding the sample bag upright 
with the septum near the bottom can also help reduce error in technique when using this 
mode, as shown in the figure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16: Proper technique for filling glass syringe from sample bag for GC 
Emulation Mode. 
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15. Choose “No” by pressing Stop when asked “Set as calibration?” to view the ethylene 
concentration on the display. 

 
 
 
 
 
 
 
 
 
 
 

16. Press Enter to start another measurement. Press Stop to exit to the Main Menu.  

17. For ethylene readings, the procedure should be calibration injection, verification injection, 
sample injection. Repeat this procedure fully for most accurate measurements, with a 
calibration and verification injection before each sample.  

  

peak count            2729747 

1.92ppm 

CO2                              0.05% 
O2                                 20.4% 
 
Uptime  00:58   Bat 85% 
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Ethylene Sensor Zero Calibration  
The baseline or zero of the ethylene sensor is known to drift, especially the C2H4 ppb sensor. The 

zero calibration should be performed daily. This can be done manually or automatically, as 

described below. In both cases, potassium permanganate (KMnO4) is used to scrub ethylene from 

the gas and set the zero. Using PolarCept (water in Chamber In) is not necessary during the zero 

calibration.  

It is not recommended to use N2 gas to zero the C2H4 sensors. N2 gas typically has hydrocarbon 

impurities which could create signal for the ethylene sensor. Standard ethylene gas (0 ppm) can be 

used to perform the zero calibration.  

Manually Set Zero 
Please see Measurement>Settings menu on page 18 for additional information.  

1. Place potassium permanganate (KMnO4) in Chamber Out. 

2. Power on the instrument and allow adequate warm-up time (3 min). 

3. Press the right arrow when Measure is highlighted to begin a measurement. 

4. Let the sensor stabilize and automatically being measuring. 

5. Once the measurement begins, press the right arrow until you access the “Settings” menu.   

6. Scroll down to “Set Zero”. 

7. Press the right arrow to highlight “C2H4”. 

8. Press Enter.  

9. A message appears asking “zero selected sensors?” 

a. Press Enter to confirm.  

10. A message appears asking to “Place KMnO4 in CH_Out.’” 

a. If KMnO4 is in Chamber Out, press Enter to confirm. 

11. The display will switch to Monitor Mode and “correcting offset” is shown at the bottom. 

a. The settings will automatically change to: 

i.  Chamber Out = On  
ii. Chamber In = Off 

iii. Closed Loop = On  
12. The instrument will wait until no more than a 40 ppb change is detected for 10 minutes 

before setting the zero calibration point.  

13. The instrument will make a “beep” sound twice to indicate that the offset correction is 
complete. The entire set zero process takes about 25 minutes.  

a. The instrument will return to Monitor/Graph Mode and “correcting offset” will no 

longer appear on the display when the zero calibration is complete.   

14. The measurement will continue with the original settings for the conditioning chambers 
and Closed Loop on/off. 
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Figure 17: Measurement > Settings Menu display (left); flow path of internal gas stream 

(right). 

 

Automatically Set Zero: Offset Autocorrection 
Please see Setup>Calibration>Offset Autocorrection on page 44 for additional information or to 

enable/disable the automatic set zero feature. The automatic offset will stop a measurement to set 

the zero, and then re-start the measurement automatically. This should be used during 

continuous monitoring or experiments longer than 24 hours.  

The offset autocorrection duration is adjustable (default: 30 minutes) and happens during “Sensor 

Stability”, the first screen when measurement mode is initiated. The default interval between offset 

autocorrections is 24 hours for continuous use, or during the next start-up for units that are not 

running continuously. If the unit is exposed to concentrations greater than 200 ppm during the 

measurement period, the offset autocorrection will be initiated the next time the user enters 

“Sensor Stability”, even if less than 24 hours have passed.   

SETTINGS 

 

Chamber OUT                 On 
Chamber IN                    Off 
Closed Loop                    On 
Set zeros                    C2H4 
 

Uptime 01:15 Bat 75% 
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F-900 Controller Software for Calibration 
The F-900 Controller software is designed to make calibration quick and easy, with many 

automated features. A major advantage of using the F-900 Controller software to calibrate the 

sensors is that all calibration parameters are updated and saved in the F-900, including calibrated 

RH, calibrated T, and internal gain. Additionally, compensation for temperature and relative 

humidity are automatically applied, based on the internal sensors of the F-900. The F-900 

Controller software is primarily used for the C2H4 PPB sensor span calibration, which is 

recommended weekly.   

Other sensors on the F-900 can be calibrated using the F-900 Controller software. The calibration of 

the RH sensor requires an external relatively humidity sensor. Each sensor must have the zero 

calibration set before carrying out the span calibration. This can be carried out with KMnO4 

and the “set zeros” calibration for ethylene, or by using N2 gas and the F-900 Controller software 

(step #1 in the F-900 Controller software “Calibration” tab).  

The CO2 PCT is calibrated at 3 known points and 0 ppm to provide the greatest accuracy for the 0-

20% range. When recalibrating the CO2 PCT sensor, choose the expected or desired range and 

calibrate with the recommended concentration. If using the 0-100% CO2 range, values above 20% 

are extrapolated and not measured due to the limitation of the sensor range. Verify with CO2 gas 

within expected range. The following table indicates what concentration of calibration gas is used at 

Felix Instruments for each sensor. 

Table 2: F-900 sensor calibration concentrations and schedule.   

Sensor Calibration 
Concentration 

Verification 
Concentration 

Zero/Span 
Calibration Schedule 

C2H4 PPM 20 ppm 10 ppm 6 months 
CO2 PPM 2000 ppm 1000 ppm Daily/6 months 
O2 50% ambient 6 months 
CO2 PCT: 0-5000 ppm 2000 ppm Within range 6 months 
CO2 PCT: 0-5% 5% Within range 6 months 
CO2 PCT: 0-20% 16% Within range 6 months 
CO2 PCT: 0-100% 16% Within range 6 months 
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Ethylene Sensor Span Calibration 
The two ethylene sensors in the F-900 have different calibration schedules. The C2H4 PPB sensor 

requires daily zero calibration and weekly span calibration, whereas the C2H4 PPM sensor requires 

zero and span calibration bi-annually (every 6 months).  

Before performing a span calibration:  

1. First perform a zero calibration (see previous section or use F-900 Controller with N2 gas).   

2. The F-900 driver must be downloaded and installed using the F-900 Package Setup v1.0.exe 

found on the webpage (http://felixinstruments.com/support/f-900-support/software), as well as 

detailed instructions. The F-900 Package Setup includes the F-900 Controller software necessary 

for the span calibration. 

 

Set C2H4 PPB Span 

1. Connect the F-900 to the PC using the USB cable. Power on the F-900 and open the F-900 

Controller software.   

a. If the F-900 display becomes frozen consistently when connecting ot the PC, it is 

possible the SD card is corrupted. To repair, insert the SD card in the computer.  If 

the PC reports disk error, choose "scan and fix". If not right click on the SD card 

drive > Properties > Tools > Scan. Press and hold the power button for 10 seconds to 

force a shut-off if the F-900 freezes.  

2. The device serial number should appear in the upper left corner of the F-900 Controller 

software and a message should appear indicating that the device is connected in USBHID 

mode. Click on the device serial number to connect to that specific instrument.  The F-900 

Controller software can have more than 1 device connected at a time.   

 

http://felixinstruments.com/support/f-900-support/software
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3. On the F-900, navigate to Measure and press the right arrow to begin a measurement. 
Press the right arrow again to skip the sensor stabilization.  

a. There is a short lag in the F-900 Controller software as it pulls data from the F-900 
instrument. This lag interval is adjustable in 1 second intervals. The monitor view 
data should begin to appear and update in the F-900 Controller software, including 
ethylene, temperature, RH, flow rate, and CO2 or O2 if optional sensors are enabled.   

 
 

4. Select the “Calibration” tab in the F-900 Controller software. Select the tab for “F-900” to see 

the various calibrations possible (Zero individual sensors with N2, Relative Humidity (RH), 

O2 Span, CO2 Span, C2H4 Span.) 

5. See the last calibration listed: C2H4: Use C2H4 standard.  

a. Select C2H4 PPB to calibrate the ppb sensor.   
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6. Enter the exact ethylene concentration from the calibration standard gas in ppb (ex: 1555 
ppb) in the F-900 Controller software. Recommended calibration gas is 1.5 ppm 
ethylene, balanced with pure air.   

7. Connect the 1.5 ppm ethylene standard gas to the F-900 intake.  Verify that the F-900 
measurement settings have Chamber In, Chamber Out and Closed Loop turned off.  

a. If using an On Demand Flow Regulator, directly connect the regulator to the IN port 
on the F-900. When using an On Demand-Flow Regulator, the gas is drawn out of the 
regulator/cylinder by the pump of the F-900. When the regulator is fully twisted 
onto the cylinder, the PSI on the gauge will move. Rotate the regulator until it is 
tightly onto the cylinder of gas (clockwise).  

i. The regulator can be removed from the cylinder (a small puff of gas will 
escape) to be used with other gas cylinders or for storage. To remove the 
regulator, twist counter-clockwise. 

 

 
Figure 18: Ethylene calibration gas cylinder with On Demand Flow Regulator 
connected to F-900 IN port. 

 
b.  If not using an On Demand Flow Regulator, be sure to use a t-valve release extra 

pressure to avoid damaging the F-900. Alternatively, a flow meter can be connected 
to be sure that the flow going into the F-900 is appropriate levels and gas is not 
being wasted. Always open the regulator very slowly and allow only 1-2 PSI (6-13 
kPa) until the ethylene value starts to increase on the F-900.   

8. Watch the ethylene data on the F-900 Controller software now that the standard gas is 
connected. The data should be trending towards the expected concentration and begin to 
stabilize.   
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9. Wait at least 7 minutes once the signal has stabilized (and does not change more than 
40 ppb) before setting the span calibration.  To set the span calibration, verify the correct 
concentration is entered in ppb in the F-900 Controller software and click the “set span” 
button. Note the value below has stabilized at 1.311 ppm.  
 

  
10. Once the set span button is pressed, the span concentration (ex: 1.555 ppm) should appear 

on the F-900 display as well as in the F-900 Controller software.  There will be a 
decrease/increase in the monitor data as the new calibration point is set and saved.  
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11. Disconnect the calibration gas and watch the data trend toward ambient ethylene levels.  
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F-900 Menu System Diagram  
Below is a map of the F-900 ethylene analyzer menu system. Press the right arrow to enter a menu 
and the left arrow or Stop to exit.  
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Setup Menu 
The F-900 has a number of utility functions that allow the user to manage the instrument’s 

capabilities. These functions are accessed by pressing the right arrow when Setup is highlighted on 

the Main Menu. The setup utility options are: Measure, Autosave, Sensor, Calibration, Time, Flow, 

Chamber, Terminals, and Board. Use the up or down arrow to select the desired option and then 

press the right arrow to enter the choice. Press the left arrow to exit to the Main Menu. 

 

 

 

 

 

 

 

 

 

Setup Measure 
The Setup>Measure menu allows the user to setup a measurement in 1 of 2 different modes: 

Monitor Mode or GC Emulation Mode. Instructions to use Monitor Mode are found on page 17. GC 

Emulation Mode is available with the F-900 Research Kit and requires the use of the inline injection 

port with septum. To save changes in the Setup>Measure menu, press Save. Use the up and down 

arrows to toggle between options. 

 

Setup Autosave  
To select the Autosave feature, press the right arrow key when Autosave is highlighted. This allows 

the user to setup the instrument to automatically store measurements, and to start a new 

measurement without explicitly saving the old one. This mode is convenient when taking fast, 

repetitive measurements, as well as when it is not necessary to review each measurement 

immediately after taking it. The files created by the F-900 are saved in .csv (comma separated 

value) format, to be opened with Microsoft Excel or other spreadsheet program.  

 
 
 
 

Setup               Menu 

 

Measure 

Autosave 

Sensor 

Calibration 

Time 

Flow 

Chamber 

Terminals 

Board 



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 40 
sales@felixinstruments.com                                         www.felixinstruments.com 

In the Setup>Autosave menu, the top line of the display will read “enter” and “save” and the 

directional arrows. Next to Autosave and “Yes” or “No” indicating whether this feature is turned on 

or off. Below Autosave is the “Interval” option where the user can set the time interval. This is the 

length of time in seconds between saves, when the autosave feature is selected. The default 

autosave interval is 10 seconds. 

 
 
 
 
 

 To set the instrument up to automatically store measurements press the right arrow key to 
highlight the word “no” on the display, then press the up/down arrow to switch to “yes”. 
Press the Save key to save the configuration. After saving, it will exit to the Setup Menu.  

 To set the instrument up to not automatically save measurements, toggle the up/down 

arrow key until “no” is on the display, then press the Save key to save the configuration. To 

save data when Autosave is disabled, press the “Save” button during the measurement.  

 When Autosave is highlighted, press the up/down arrow to get to the Interval line and then 

use the right arrow key to highlight the time interval value. Press the up/down arrow key to 

change the time interval. Press Save to save changes. 

 To avoid changing any configuration, press the Stop key to exit back to the Setup Menu. 

  

Autosave             Menu 


Autosave                  Yes 
Interval                    010 
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Setup Sensor 
The Setup>Sensor Menu has three options, Sensor Selection, Sensor Voltammetry and Cell 

Hydration. Sensor Selection allows the user to turn on/off the different sensors of the F-900. After 

selecting any of the menu options from the Setup>Sensor menu, the display will prompt “Are you 

sure you want to continue?” Press Enter to continue to the selection.  

Not all F-900’s are built with all sensors, so see the Production Check Sheet at the end of the manual 

to see which sensors are included in your unit. All units are equipped with a High Resolution C2H4, 

ethylene sensor (PPB) and an extended range C2H4, ethylene sensor (PPM). The C2H4 PPB measures 

from 0-2 ppm. The C2H4 PPM measures from 2-200 ppm, with a lower detection limit of 0.5 ppm. 

Optional sensors available for carbon dioxide are the PPM or the PCT, which gives values in percent 

(%). There is also an additional sensor available for O2 (percent oxygen). The optional sensors are 

in series, meaning the gas sample will flow to the CO2 PPM, then CO2 PCT sensor, then O2 sensor. 

The C2H4 sensors are parallel, meaning a valve changes the gas flow between the C2H4 sensors, 

again depending on the current concentration.  

Sensor Selection: Press the right arrow when Sensor Selection is highlighted to see the list of 

sensors.  

 

 

 

 

 

 Use the up/down arrows to select the sensor to adjust and then the left/right arrow keys to 

switch between columns. Once in the column with the On/Off, use the up/down arrow to 

turn the sensor On/Off.  

 Both ethylene sensors should always be turned “On” for measurements. The 

firmware will control which ethylene sensor is used to measure the gas sample.  

 If sensors are not included in your instrument, please set them to “Off”.  

 If not actively using the CO2 PPM sensor, set it to “Off” to conserve battery life.  

 Press Save to save any changes.  

 Press Stop to exit to the Setup Menu.  

 

 

Setup        Sensor 

 

C2H4  PPB         On 

C2H4  PPM        On 

CO2    PPM        Off 

CO2    PCT    Off 

O2                     Off 
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Sensor Voltammetry should only be used if instructed by a CID technician. 

Sensor voltammetry is the electrode recovery mode and is a useful tool if the electrochemical cell 

has been poisoned. However, running Sensor Voltammetry may cause the calibration to shift, 

changing the data displayed on the screen. 

During this process the pump will be turned off and a series of voltage changes will occur on the 

sensor. First, voltage changes serve to oxidize anything on the electrode, followed by reduction and 

finally, a re-stabilization period for the sensor. The cleaning will take about 40 minutes to complete, 

and the sensor may be very sensitive and noisy for a period of time following the cleaning.  

If Sensor Voltammetry is selected by mistake, please press the Stop key to exit, as instructed on the 

display. 

 

Cell Hydration menu features options and details about the water status of the electrochemical 

sensor. The weight is set to 0.00 grams when the electrochemical cell is completely full, prior to it 

being shipped from Felix Instruments. As the cell loses water, the weight will become a negative 

value. If the weight is greater than -10.0 g, the instrument should be hydrated by 10 cc (1cc = 1 g). A 

positive value indicates hydration, a negative value indicates dehydration of the cell.  

A message on the display to “check cell hydration” indicates 2 possibilities: the ethylene sensor is 

dehydrated or overhydrated. Rehydrating the ethylene sensor is critical to maintain the instrument 

and accurate readings.  

 

 

 

When this message appears, weigh the entire F-900 (with no water or consumables in the 

conditioning chambers). Compare this weight to the weight on the Production Check Sheet on the 

last page of this manual.  

To rehydrate the electrochemical sensor, the instrument should be in the closed loop mode. 

Distilled water should be placed in Chamber In and it should be enabled. Let the instrument 

run for 12 hours to rehydrate the ethylene sensor. Press stop to exit this mode and return to the 

Setup Sensor Menu. Re-weigh the instrument to determine if more hydration is needed. Always 

have fresh distilled water in Chamber In when rehydrating the electrochemical cell. 

To dehydrate the sensor, place the instrument in Closed Loop mode with silica gel (humidity 

scrubber) in one of the conditioning chambers. Enable the chamber with the silica gel and let run 

overnight. Press Stop to exit this mode and return to the Setup Sensor Menu. Re-weigh the 

instrument to determine if more dehydration is needed.  

Cell Hydration 

Weight (g)         -000.297709 

RH sync 

RH reset 
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Finally, reset the hydration value in the Cell Hydration menu to the current weight minus the 

shipped weight using the up/down arrows to adjust the value for weight. (Current weight – original 

weight).  

 

RH Sync feature will synchronize the two relative humidity sensors inside the instrument 

(upstream and downstream of the ethylene sensor). This should only be done at the instruction of a 

technician.  

RH reset serves to calibrate the relative humidity sensor. This calibration requires N2 gas and 

should only be done by a technician. The calibration has two parts. The first part of the calibration 

will set the zero or baseline for each relative humidity sensor. The second part of the calibration 

will set the span (known value) for both RH sensors. This requires precise control of temperature 

and humidity of the entire instrument.   



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 44 
sales@felixinstruments.com                                         www.felixinstruments.com 

Setup Calibration 
Current Calibration Parameters and re-calibration steps for C2H4, CO2, and O2 sensors can be found 

in the Calibration Menu. Press Enter to confirm and get into the menu. The options at the 

Setup>Calibration menu are C2H4, CO2, O2, system DAC and flow.  

C2H4 Calibration  

**Re-calibration or changes to any of the Calibration Parameters for C2H4 must be performed 

under the supervision of a Felix Instruments technician only.** 

The options from the C2H4 Calibration menu are for the C2H4 PPM sensor, C2H4 PPB, offset 

autocorrection or sensitivity correction. Calibration Parameters are set by a Felix Instruments 

technician during factory calibration and are specific to each instrument. The internal offset is the 

ADC voltage output from the sensor when no ethylene is present, and gain describes the linear 

increase in the ADC voltage output from the sensor in the presence of ethylene. The RH, T slope and 

offset are applied to the ADC voltage to correct for shifts in relative humidity and temperature that 

may occur during the sample period. 

 

 

 

 

 

The ethylene sensor calibration will drift over time. Occasional recalibration of the sensors can be 

carried out using calibration gas in the range of each ethylene sensor. For example, 1 ppm C2H4 gas 

can be used to adjust the internal gain reading for the C2H4 PPB sensor. To adjust the internal gain 

of the C2H4 PPM sensor, standard gas between 5-100 ppm could be used. The timeframe for 

adjusting the gain depends on the specific sensor and its use. The C2H4 PPB sensor may require 

weekly gain adjustments, while the C2H4 PPB sensor may require gain adjustments every 6 months.  

 

C2H4 PPB Re-Calibration (Manual) 

It is recommended to use the F-900 Controller software for automated calibration of the F-900 

C2H4 PPB span (page 32), but a manual calibration is possible with an On Demand Flow Regulator 

and C2H4 standard gas (Setup > Calibration > C2H4 > PPB > Re-calibration). Always perform a 

zero calibration of the ethylene sensors using KMnO4 before setting the span. Run the 

calibration gas for at least 15 minutes to ensure correctly reading calibration standard. Use the 

following formula to find the new internal gain and update it in the Calibration Parameters menu, 

where solving for “x” is the new internal gain. The measured concentration is what the F-900 is 

reading the calibration gas as. Do not use the Chamber In with water when performing calibrations.  

Calibration               Parameters 
 
Internal offset 
Internal gain 
Calibrated RH 
Calibrated t 
RH slope 
RH offset 
t slope 
t offset 
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Enter the temperature on the display of the F-900 as the “calibrated T” when the gain is adjusted. 

Press Save to save the new internal gain calibration value.  

 

 

Injection Parameters 

With additional sensors added to the F-900, additional internal volume is added and the amount of 
volume becomes specific to each instrument and the amount of tubing used. In order to determine 
the calibration volume for GC Emulation Mode using either CO2 or O2 sensors, the following formula 
is used. The results are saved on your ethylene analyzer and in the Production Test Check Sheet in 
this manual. 
 
 
 
 

 Xi: Injected gas concentration (%) 
 Xo: Initial concentration (%) 
 Xf: Final concentration (%) 
 Vi: Injected gas volume (mL) 
 V: Volume of gas stream in instrument (mL) 

 
In GC Emulation Mode, start a measurement and setup the injection port (chambers off, closed loop 
off). Record stabilized value of target gas. This value is Xo. Next, prepare injection gas (such as 4% 
CO2 or 50% O2), record Vi and Xi, then inject gas. Record stabilized value “Xf” of target gas. Calculate 
V using the formula above. This should be repeated several times, and the average should be taken. 
The average calibrated volume (V) has been determined and entered in the Setup>Calibration> 
press enter>CO2 or O2>Injection Parameters menu by a technician at the factory.  
 

Offset Autocorrection 

Offset autocorrection allows the unit to adjust the baseline, or zero, for the ethylene sensors, which 

may drift from the zero set at the time of calibration. The offset autocorrection procedure typically 

takes about 25-30 minutes and takes place during “Sensor Stability”, the first screen when 

measurement mode is initiated. The default interval between offset autocorrections is 24 hours for 

continuous use, or during the next start-up for units that are not running continuously. If the unit is 

exposed to concentrations greater than 200 ppm during the measurement period, the offset 

autocorrection will be initiated the next time the user enters “Sensor Stability”, even if less than 24 

hours have passed. The offset autocorrection relies on there being KMnO4 in Chamber Out.  

 

 

 

 

         X              =   measured concentration 
Original gain      standard gas concentration 

    Offset Autocorrection 

 

Adjust enable  Yes 

interval (hour)  024 

requesting  Yes 

V= ((Xi-Xo)*Vi) 
(Xf-Xo) 
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Adjust enable: If “Yes” is selected, the unit will automatically adjust the offset every 24 hours or 

upon startup if more than 24 hours have passed between uses. The offset will be corrected when 

the user first enters measurement mode and is in the “Sensor Stability” screen. To enable the 

automatic offset adjustment, and to ensure that the latest offset adjustment so that the unit is using 

the most recent zero, change the “Adjust enable” line to “Yes”. To return to factory calibration 

parameters, select “No”.  

Interval: The offset autocorrection interval can be changed from 24 hours (default) to any user 

selected interval in hours.  

Requesting: If “Requesting” is reading “No” while adjust enable is on, the unit has recently set the 

offset and will not enter the offset autocorrection the next time the “Sensor Stability” screen is 

entered. If “Requesting” reads “Yes”, the unit will begin resetting the offset the next time 

measurement mode is initiated and “Sensor Stability” is entered.  

 

Sensitivity Correction 

The sensitivity correction is for adjusting the internal gain value of the C2H4 sensors. Ethylene gas 

standards are required. The Sensitivity Correction feature is currently in process and will be 

completed in a future version of firmware.  

 

CO2 Calibration  

It is recommended to use the F-900 Controller software for automated calibration of the F-900 

CO2 span (page 32), but a manual calibration is possible Always perform a zero calibration of the 

sensor before setting the span. 

To access the Calibrate CO2 feature of the F-900, press the right arrow key when Calibration is 

highlighted on the Setup Menu. Press Enter to continue to the Calibration mode. Select the CO2 

sensor to be calibrated (PPM or PCT).  

 

 

 

 

 

The CO2 sensor needs to be enabled in the Setup>Sensor menu to access the Setup>CO2 menu. To 

calibrate the CO2 PPM sensor, 400 ppm or 600 ppm standard CO2 gas is recommended. To Calibrate 

the CO2 PCT, 4-20% CO2 is recommended. Allow the gas to run for 20-30 minutes before calibration.  

Calibration Parameters will display the coefficients from the previous calibration.  

CO2 CALIBRATION 

 

CO2 PPM 

CO2 PCT 
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Re-calibration allows the user to re-calibrate the sensor, setting a new zero and span for the 

selected sensor. CO2 PPM zero calibration is recommended daily. CO2 PCT zero calibration is 

recommended every six months. However, if the unit is in an environment where the 

temperature fluctuates frequently, zero calibration may be necessary more often than the 

recommended intervals. Alternatively, a CO2 scrubber such as soda lime can be placed in Chamber 

Out.  

Turn the ethylene sensors on for the CO2 calibration. Directions for using a buffer system in 

place of a standard gas may be found at the end of the section. 

 

 

Figure 19: Calibrating the CO2 sensor using standardized gas. 

 

The CO2 PPM zero calibration will drift with time and temperature therefore daily zero calibration 

is recommended for the CO2 PPM sensor. If performing the CO2 span calibration, it should be carried 

out immediately after the CO2 zero calibration. The span calibration is required every 6 months. 

The CO2 span or gain calibration does NOT need to be performed every time the CO2 zero is 

set.  

When performing the CO2 span calibration, use standardized gas with at least 100 ppm CO2, but not 

over the range of the CO2 sensor (2000 ppm or 3000 ppm, check the production test check sheet at 

the end of the manual for CO2 sensor information). See Table 2 on page 32 for the recommended 

standard gas concentration for calibration of each sensor.   

Calibrating the CO2 sensor with standardized gas is fairly simple and takes 20-30 minutes. 

Remember, to always use a "T" connection to vent excess gas and prevent damage to the 

internal components.  

1. Go to Setup>Calibration, press Enter, then select CO2. Select the CO2 sensor to calibrate. 

2. Go to Re-calibration and press the right arrow. You will hear the valves open and the 

pump begin to run.  
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3. The display will read Setup N2 and press Enter. If you have pure N2 gas (0 ppm CO2), 

connect it to the inlet of the device. Be sure to have a “T” in the line so that the 

instrument and seals are not over pressurized. Use the regulator on the gas tank to set 

the flow to just over 1 PSI. This will ensure the unit is provided with a bit more than the 

necessary gas for it to operate at 200 ml/min (wasting calibration gas will happen at 

over 2 PSI).  

If N2 gas is not accessible, use the Soda Lime provided with the research kit. 

Create a 0 ppm CO2 environment by filling the external conditioning tube with 

soda lime and connecting it to the inlet. This will generate CO2 free air, allowing 

the instrument to set the zero as it would with the N2 gas.  

4. Once the N2 gas or soda lime is connected, press Enter. The instrument will enter a 

screen that reads “Internal Offset” and count down from 99.  

5. When the offset is obtained, the instrument will pause and allow you to calibrate to 

either the 20% range or 100% range. For example, if you need the instrument to read 

50%, press “Save” to calibrate to the 100% range. 

6. In the Setup Gas screen, connect the CO2 (use a “T” connection to not over pressurize the 

instrument) and change the value to 00050 %. Press “Save”. 

7. The instrument will now set the internal gain and count down from about 46.  

8. The final calibration values will then be displayed. Press “Save” to save the values, 

completing the calibration and returning to the Calibration Menu. 

 

 

 

 

 

 

 

 

If access to standardized CO2 gas is limited, ambient air can be used to calibrate the CO2 span. 

Ambient air should only be used if a buffer tank system is implemented. The buffer tank system will 

help stabilize fluctuations in CO2 levels, providing an ambient air with approximately 400 ppm CO2 

(depending on proximity to urbanized areas).  

Tips for Calibrating the F-900 CO2 Sensor with a buffer system: 

 The operator should stand away from the F-900. 

 Use extra tubing to get the intake source away from human breath. 

 Use a buffer tank system to stabilize the intake source. 

Calibration Results 

 

zero                              0 

span         (600) 0000 
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CO2 Span Buffer Tank System Instructions 

1. Find and clean an empty bottle with cap, 

which is at least 3L in volume. 

2. Drill two small holes in the cap of the buffer 

bottle: 1 hole is for the intake tube and 1 hole 

is for the out tubing. 

 

 

 

 

3. Insert a short plastic tube into the cap of the 

buffer bottle for the “out”.  

 

 

 

 

 

4. Insert a longer plastic tube into the cap of the 

buffer bottle that will connect to the “IN” of 

the instrument. Use hot glue or otherwise 

seal the tubing to the cap, with no leaks. 
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5. Make sure that the tube and cap has no leaks. 

 

 

 

 

 

 

6. Connect the “in” tubing to the intake port on 

the instrument. 

 

 

 

 

 

 

7. To use the buffer bottle, make sure that the 

tubing is clear from obstruction. Connect the 

In tubing to the unit. Place the buffer bottle 

in a location that has stable CO2 

concentration (away from operator, cars, 

furnace, photosynthesizing plants). Here, 

ambient air CO2 levels should be 

approximately 400 ppm. 

 

 

Note: The instrument shown in these images is a CI-340 Photosynthesis Analyzer (CID Bio-Science, 

Inc). The buffer tank system technique can be used to help stabilize the ambient intake of any IRGA 

CO2 sensor (images courtesy of ZealQuest, China).   
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O2 Calibration  

It is recommended to use the F-900 Controller software for automated calibration of the F-900 O2 

span (page 32), but a manual calibration is possible Always perform a zero calibration of the 

sensor before setting the span. 

The offset and gain from the previous calibration can be seen under Calibration Parameters. These 

values are achieved by setting a zero and a span for the unit. To re-calibrate, pressurized N2 gas and 

O2 gas will be needed. If O2 gas is not available, ambient air may be used. Annual re-calibration is 

recommended, but if the environment changes frequently, re-calibration may be required more 

often. To set the zero of the O2 sensor, follow the same instructions for the CO2 sensor zero 

calibration, with the following changes: 

1. Use 0 ppm O2 gas. 

2. Highlight O2 in the Measure>Settings menu and press Enter twice when it is time to set 

the zero. 

Calibrating the O2 sensor with standardized gas is fairly simple. Remember, to always use a "T" 

connection to vent excess gas and prevent damage to the internal components.  

1. Go to Calibration, press Enter, then O2.  

2. Go to Re-calibration and press the right arrow. You will hear the valves open and the 

pump begin to run.  

3. Use pressurized N2 to create zero O2 gas. When the gas is flowing and connected to the 

unit, press Enter. 

4. The unit will count down as it sets the zero for the O2 sensor. The humidity, 

Temperature, and Flow are displayed. The flow should continue to read 200 mL 

throughout the calibration- if it does not you may have a leak or obstructed tube. 

(Pressing Enter at any time will move you into the next step. Only do so if you want to 

use the previous zero calibration). 

5. Setup Calibration gas: Enter the percent concentration, where 1000 E-3 = 100% and 

210 E-3= 21%. Use the left/right arrow keys to switch between placeholders, and the 

up/down arrows to change the values.  

6. Press Save to initiate the calibration.  

7. The unit will count down from 19 as it sets the span for the O2 sensor. (Pressing Enter at 

any time will move you into the next step. Only do so if you want to use the previous 

span calibration). 

8. After the unit has set the zero and the span for the O2 sensor, the Calibration Results are 

displayed. Press Save to save the values and return to the Calibration Menu. 
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Flow Rate Calibration 

To calibrate the flow rate on the F-900, a separate flow meter is required. The external flow meter 

should work with gas and a range including 100-700 ml per minute.  

1. Go to Setup > Calibration > Flow. 

2. Connect a calibrated external flow meter to the OUT port of the F-900. 

3. Follow the instructions on the display of the F-900 to set up the calibration points. 

4. Use the up/down arrows to adjust the flow until the external flow meter reads the proper 

calibration point. 

5. The higher calibration points are above the maximum flow rate the pump is capable of 

producing, so once the ball no longer raises on the flow meter, press Enter for the last few 

points. Calibrate flow at the following points: 

a. 100 ml/min 

b. 200 ml/min 

c. 250 ml/min 

d. 300 ml/min 

e. 400 ml/min 

f. 500 ml/min 

g. 600 ml/min 

h. 700 ml/min: if external flow meter does not increase, press Enter 

i. 800 ml/min: if external flow meter does not increase, press Enter 

j. 900 ml/min: if external flow meter does not increase, press Enter 

6. Press Enter after the last calibration point. 

7. Go to Setup > Flow to verify flow rate at 100, 200 and 300 ml/min.   

 

Setup Time and Date 
To change the time and date on the F-900, press the right arrow when “Time” is highlighted on the 

Setup Menu. This utility allows the user to set-up the instrument in different time zones or to adjust 

the time after daylight savings.  

 To change the time on the instrument, use the up/down arrows to change the values. Use 

the left/right arrow to highlight the appropriate column. Then, make the appropriate shift 

in time and press Save.  

 
 
 
 
 
 

Setup                              Time

 

03  28  2013     16 : 33 : 24 
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Setup Flow 
The air flow of the F-900 is an important factor for taking good measurements. The default flow 

rate is 200 ml/min. Flow rate is adjustable from 100-500 ml/min.  

A flow value below 100 ml/min can negatively impact sensor functionality. If measuring bottled 

gas, a lower flow rate may be used in order to reduce gas waste. If measuring open air, a higher flow 

rate (~300 ml/min) is acceptable. The default flow rate is 200 ml/min.  

 

 

 

 

 

 

 

 

To make adjustments: 

1. Go to Setup>Flow and press the right arrow. 

2. Use the up/down arrows to adjust the value. 

3. The Set Flow value is found in ml/min to the far right.  

4. The Actual Flow value will change to match the set flow. 

5. Press Save to save changes and exit back to the Setup Menu. 

6. Press Stop to exit back to the Setup Menu without saving. 
  

Setup                                              Flow

 

Set Flow                                        200 

Actual Flow              200
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Setup Chamber 
The Setup>Chamber menu allows you to turn on/off the in-line conditioning columns on the back of 

the instrument. The settings in Setup>Chamber are the default settings to be used to start a 

measurement. Once a measurement is in process, conditioning chambers can be turned on/off in 

the Measurement>Settings menu. If the measurement is started with PolarCept enabled, the 

measurement must be stopped to make changes to Chamber In at the Setup > Chamber menu.  

The removable plastic containers are used to hold the consumables potassium permanganate, 

distilled water, soda lime, and silica gel. Keep the plastic containers on the F-900, even when 

empty, to protect the brass intakes. Always ensure the conditioning chamber is seated 

properly when screwing it on the F-900. 

The purpose of the inbound chamber, Chamber In is to condition the air before it reaches the 

sensor. Chamber In additionally provides a “special mode” where distilled water is used to filter out 

alcohols before the electrochemical sensor. The use of distilled water in the Chamber In is referred 

to as PolarCept. It is recommended to use PolarCept (Chamber In: Special) for most ethylene 

measurements. PolarCept is intended for distilled or deionized water only.  

 

 

 

 

 

 

 

 

 

Figure 20: Solids Chamber and Water Chamber on back of instrument.  

Chamber Out is on the left of the back panel. Chamber Out is the last chamber before the gas OUT 

port. If the outlet gas stream is connected to the field kit chamber or to the inlet of the unit, it can be 

used to condition the incoming gas after it leaves the sensor. Chamber Out is used with 

potassium permanganate (KMnO4) for zero calibration of ethylene sensors. 

Alternatively, Chamber Out could be used with soda lime to remove CO2 from the gas stream. 

Similarly, silica gel is used to scrub water from air and create a 0% relative humidity gas. Most 

commonly, potassium permanganate is used to for zero calibration of the ethylene sensor. KMnO4 

beads (not dust) should be sourced locally by the user.  
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KMnO4 has an added color indicator that turns from purple to brown when it expires and 

needs replacement. The silica gel from blue to pink when replacement is necessary.  

To use Chamber Out to condition the air replenishing the fruit chamber, enable Chamber Out in the 

Setup>Chamber menu and fill Chamber Out with the appropriate consumable. Connect the fruit 

chamber hoses to both the IN and OUT ports on the front of the F-900.  

 

 

 

 

Figure 21: The back of the F-900 with removable and refillable containers for distilled water 

and KMnO4 (left) and a diagram showing the flow path of the gas stream (right). 

Chamber In is on the right side of the back panel. This chamber can be enabled in 2 different modes. 

For PolarCept, Chamber In should be filled with distilled water to help filter out interfering gases 

in the air stream. By passing the gas sample through the water, polar molecules are trapped or 

filtered from the airstream. Using Chamber In with distilled water as a filter can help reduce the 

interference measured when alcohol or other light polar molecules (known interfering gases for the 

F-900 electrochemical sensor) are present. Also, using the water trap can help keep the 

electrochemical cell hydrated, with longer periods of time between needing to refill the 

electrochemical sensor.  
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There are 3 options for Chamber In in the Setup>Chamber menu.  

1. Chamber In set to Off. 

2. Chamber In set to On. 

a. To use soda lime or silica gel to condition the gas stream before it is 

measured, turn Chamber In to On and place the consumable in the 

conditioning chamber.  

3. Chamber In set to Special. This is the setting for PolarCept. 

Use the up/down arrows to select Chamber Out or Chamber In. Use the right arrow to get to Off/On. 

Next, use the up/down arrow to switch between On or Off, or set the Measure or Cleaning period in 

minutes. When Chamber In is set to Special, you will see Measure and Cleaning Period appear 

below.  

 

 
 
 
 
 
 
 

 Fill Chamber In with distilled water to max fill line (located on back of F-900)  

 The water level of Chamber In should to be refilled every 120 hours when using PolarCept. 

 This mode may not be applicable at high ethylene concentrations. 

 When the F-900 is using the water to filter out alcohol, the water must be cleaned by 

running a longer cleaning period than the measure period.  

 

To use the PolarCept water trap, set Chamber In to Special. Fill Chamber In less than half full with 

distilled water. There is a fill line on the back of the instrument. Next, set the length of the 

measuring period in minutes. This is the time the F-900 will take to do a measurement. When using 

the water trap, a settling time of at least 3 minutes is required before being able to record a 

measurement. At a measuring time of 5 minutes, the reading is settled, but the overall 

measurement will take longer. A measuring period of 3-5 minutes is sufficient to achieve an 

accurate reading. After 5 minutes you run the risk of reaching saturation. Actual times will depend 

on application/environment.  

The length of time required for cleaning will be dependent on the make-up of the gas(es) being 

sampled. The more interfering gases that are present, the longer the water will need to be cleaned. 

The main reason for the cleaning step is to keep the water in the maximum adsorption range. As the 

water becomes polluted with alcohols, it will not filter as effectively. This results in an increase in 

signal from interfering gasses escaping the filter. A small measurement to cleaning time ratio is 

Chamber                    Menu 

 

CHAMBER_A OUT             Off 

CHAMBER_B     IN           SPECIAL 

MEASURE PERIOD              3 MIN 

CLEANING PERIOD          17 MIN 
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suggested because the longer the measure time with the filter, the longer it will take to clean. A 

recommendation of 5 minutes of measure and 12 minutes of cleaning is better than 20 minutes 

of measure and 60 minutes of cleaning. For long-term monitoring, cleaning time may need to be 

extended upwards of 50-60 minutes. At the end of the cleaning time, the C2H4 reading should be low 

(less than 0.2 ppm). If not, lengthen the cleaning time and repeat the test.  

When the F-900 has PolarCept turned on, the Monitor Mode display top line will indicate B_SPEC, 

meaning that Chamber In is enabled in Special mode. Next, the current state (measure or cleaning) 

will be shown. If the F-900 is in a state of Measure, the data will reflect the current measurement. If 

the F-900 is in a state of Cleaning, “Clean” is shown in the upper right corner of the display.  

 
 
 
 
 
 
 
 
The F-900 has two hydrophobic filters in-line with the internal tubing. This is to protect the F-900 
in case any water is sucked into the instrument when using PolarCept. To avoid drawing water 
into the internal tubing of the F-900 when using PolarCept: 

1. Fill conditioning Chamber In only to the fill line and never completely fill the conditioning 
chamber with water. 

2. Always keep the top panel of the F-900 facing up and do not tilt the instrument when 
there is water in the conditioning chamber. When water in Chamber In, do not operate the 
instrument with the display panel facing upwards.  

3. Do not transport or tip the F-900 if water or moisture is in Chamber In. Before 

transport or moving the F-900, Chamber In should be completely dry to prevent even small 

drops of liquid from entering the unit. 

4. If the Relative Humidity sensor reads high or a “flow blocked” error appears on the display, 
open the top panel of the unit and inspect hoses for liquid. If liquid has accumulated at the 
hydrophobic (blue) filter, it should be disconnected and drained. If liquid has penetrated the 
hydrophobic filter the unit will need to be serviced to prevent circuit board failure. Contact 
support@felixinstruments.com with any questions. 

 

  

B_SPEC                       MEASURE 

0.160 ppm 
HUMIDITY                        47.0% 

TEMPERATURE               28.7C 

PRESSURE                 100.4KPa 

mailto:support@felixinstruments.com
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Setup Terminals 
The Setup>Terminals Menu is where the F-900 can be setup to have an external fan or gas control 

connected to the terminal block. The terminal block is located between the chambers for 

consumables on the back panel of the F-900. The F-900 can turn on and off the gas based on the 

measured ethylene concentration of the room (or chamber). Other control applications using the 

terminal block are possible, such as controlling ethylene scrubbers or connection to an external 

control system.  

The F-900 will perform action at the high and low levels, when set. If the concentration of ethylene 

rises above the Gas_Hi, the gas will be shut off. If the ethylene concentration is lower than the 

Gas_Lo, the gas will be turned on.  

 
 
 
 
 
 
 
 
 
 

 Press the up/down arrow to switch between parameters.  

 Press the right arrow to switch to the column containing the values in ppb (parts per 
billion).  

 Use the up/down arrow keys to set the desired level.  

 Press the left arrow or Save to exit back to the Setup Menu. Any changes made will 
automatically be saved. 

 Enabling CONTL_OUT will turn on the standard terminal control, using the output of the 
pins to control turning on or off the gas and/or the exhaust fan.  

 Enabling CONTL_IN (Clean) allows use of the analog input pin to supply a voltage to control 
the cleaning mode (input signal). This terminal control mode was developed for using the F-
900 with other external advanced control systems. When this mode is not being used, set to 
DISABLE.  

o Note: if Setup>Chamber: Chamber In is currently set to Special, enabling CNTL_IN 
(CLEAN) will overwrite Chamber In to Off. 

o Terminal Connections:  

 Pin 1: Ground 

 Pin 10: Control voltage. Control voltage could be applied during 
Measure>Monitor Mode to control cleaning mode. Specifically: 

 0.0-1.0V: Cleaning disable (Closed Loop Off, Chamber In Off) 

 1.5-5.0V: Cleaning enable (Closed Loop On, Chamber In On) 

Setup                       Terminals 
VALUE                            PPB 
 
GAS_HI                         00000 

GAS_LO                        00000 

CONTL_OUT              DISABLE 

CONTL_IN (Clean)   DISABLE 
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To connect a gas control to the terminal block of the F-900, first pull off the removable portion of 

the terminal block (pull straight out). The piece in the figure below will separate from the F-900. 

Slide the wire from what is going to be controlled through the opening for the appropriate pin. Use 

a screw driver to tighten and clamp onto the wire, creating a connection. The removable section of 

the terminal block is designed to stay with the fan, gas or external control so, if the F-900 needs to 

be moved, the terminal block can be disconnected easily.  

 
 Figure 22: The removable piece of the F-900 terminal block. 
 
Table 3: Designations of the 10 pins of the terminal block (On = 5V; Off = OV): 

PIN  Function 

1 and 2 Ground 

3 Plus 5 volts (limited through 4.7 ohm resistor) 
4 Gas valve control (C2H4): when CONTL_OUT is ENABLE, OFF if C2H4 > GAS_HI, ON if 

C2H4 < GAS_LO 

5 Ready signal (5V): ON if during measurement (except correcting offset), OFF otherwise 

6 Alarm or error indicator: ON if one of the following happen: battery low/flow 
blocked/signal out of range/sensor error, OFF otherwise 

7  C2H4 analog output: 4-20mA for 0 - max C2H4 range (20ppm or 200ppm) 

8 CO2 analog output: 4-20mA for 0 - max CO2 range (2000ppm or 100%) 
9 Not implemented (NC) 

10 Analog control input for cleaning: use with CONTL_IN enabled 

 

Setup Board 
The Setup Board Menu should only be changed by a Felix Instruments technician. This menu allows 
the user the select the type of hardware platform that the unit operates on, and should only be 
changed at installation, or if hardware is upgraded.  
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View Menu 
The View Menu can be accessed from the main menu screen by pressing the right arrow key when 

“View” is highlighted on the display. This menu allows the user to navigate to and see the files, as 

well as check on many features of the F-900. Options from the View Menu are: Files, Voltage, 

Battery, Flash, Time, GPS, and SD card.  

 

View Files 
The View>Files Menu allows the user to review the filenames and file size of any files on the F-900. 

To view collected and saved data, either download files via USB or eject the SD card and insert it in 

a computer. In the View>Files mode, the top line of the display will show the word “View” on the 

left and “Files” on the right. Below this, the column on the left contains the filename and the column 

on the right contains the file size.  

The options are: 

 use the up or down arrow keys to scroll through the files  

 press the left arrow or Stop to exit to the View Menu 
 
 
 
 
 
 
 
 
Note: A file with a negative number for the file size is corrupt. This file should be deleted and re-
created. 

View                                    Files 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 
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View Voltage 
The View>Voltage Menu shows the current voltage of the instrument. Press the right arrow when 

Voltage is highlighted to check the unit’s voltage. If any of these numbers are rapidly changing after 

the instrument has warmed up, please contact technical support at support@felixinstruments.com. 

Press the left arrow or Stop to exit back to the View Menu.  

Voltage is set for each individual unit before leaving the Felix Instruments factory and is board 

specific. For default voltage values, please see the Production Test Check Sheet at the end of the 

Instruction Manual for factory voltage settings. V_System is the voltage of the control board. The 

voltage for V_Charger should increase when you connect the USB charger. V_3volt is the digital 

voltage from the CPU and the V_Analog is the converted analog voltage.  

 

 

 

 

View Battery 
The View>Battery Menu displays indicates on the top line if the unit’s Charging is On or Off, or if the 

unit is connected via USB cable to a computer. The QBAT value shows the battery level in 

hexadecimal follow immediately by the battery level in percent. VBAT shows the voltage of the 

battery and TBAT indicates if the temperature of the battery is ok. The Charge shows the output 

status of the battery charger. Press the left arrow or Stop to exit to the View Menu.  

 
 
 
 
 
 
 
 
 

When the instrument is connected to the charger, the top line will indicated Charge On. Charge Off 

indicates that the unit is not charging. USB Host in the upper left corner indicates that the unit is 

connected to the computer or that the power supplied by the charger is not full charging voltage 

(unplug any other devices using the same charger).  

The QBAT hexadecimal number should be changing and the battery percent increasing. Also, the 
voltage will begin to increase slowly. The Charge will read “off” when no charger is plugged in and 
“Complete” when finished charging. The Board refers to the hardware version of the unit. Features 
described in this manual are associated with all versions of hardware. When discrepancies occur, 
they are listed, along with the version that they are associated with.  

Charge                Off 

 

QBAT:    a413   60% 

VBAT:    3.840V 

TBAT:   OK 

Charge:         Off 

Board:  v6 

View                          Voltages 

V_System     =     5.98v 

V_Charger    =    4.64v 

V_3volt         =    3.31v 

V_Analog      =    2.07v 

mailto:support@felixinstruments.com
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Other View Menu Options 
The View>Flash option is only accessible by Felix Instruments technicians.  

The View>Time screen displays the current time on the instrument. Press the left arrow or Stop to 

exit back to the View Menu. The View>SD card screen indicates if an SD card is present in the unit, 

as well as other information about the SD card. If no SD card is in the instrument, or if the SD card is 

not fully inserted, “no SD card” will appear on the display. 

 
 

 

 
 

GPS System Features 

The F-900 has a built-in GPS system which can relay the longitude, latitude and altitude of the 

instrument when performing measurements. The View>GPS screen displays the mode of the GPS 

sensor (SEN= $GPGGA), as well as the values for latitude, longitude, altitude and indicates the 

number of satellites currently connected to. Press the up/down arrow to display the latitude, 

longitude and altitude information only.  

 

 

 

 

 

The GPS uses GMT or Greenwich Mean Time for a standardized time. The GMT is displayed as the 

time (TIM) on the GPS menu and is synchronized with minute and second alignment. Often, when 

the instrument is turned on indoors, the latitude, longitude and altitude will be blank. This occurs 

when no satellite signal can be obtained by the instrument. Powering up the F-900 outdoors will 

correct this problem and allow latitude, longitude and altitude readings to be taken. 

                 <stop> 

 

SDcard                     Present 

CardSize  =        3935MB 

NumSectors  =  8058880 

BlockSize   =      512B 

<stop>       <save>                      

SEN =                                          $GPGGA 
SAT =                                                      05 
TIM =                                  015546.806 
LAT =                                   45.58792          
LON =                                  -122.37459 
ALT =                                            10.6 
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 File Menu 
The File Menu is accessed by highlighting “File” on the Main Menu and pressing the right arrow key. 

Here, the user can manipulate files on the F-900, with options to clear, delete, create and open files.  

The F-900 uses an SD card to store all measurements. This means the user is able to create, clear 

and delete any measurement file.  

To view data on a computer, simply insert the SD card into the computer’s SD card reader. The 

computer should automatically detect the SD card as a new storage device and mount the drive so 

that measurement data will be accessible by any computer application. The mini-USB port can also 

be used to establish a USB connection with a computer to transfer data from the F-900.  

 

Clear a File 
Pressing the right arrow key when “Clear” is highlighted on the display enters the menu to clear 

files. This mode allows the erasure of the file contents without changing the file name or set-up. 

This feature is useful if it is necessary to do a number of similar measurements. The user can take 

these measurements to a particular file, copy the results, clear the file, and be ready to take a new 

set of measurements to that file. 

 

 

 

 

The top line of the display reads “Clear” on the left and file on the right. Filenames are listed on the 

left and the file size is listed in the right column. An empty file will have a zero as the file size.  

 Use the up or down keys to select the file to clear.  

 Press the right arrow to clear the file.  

 Press Enter to confirm. 

 The display will indicate “Done!” when the file is erased.  

 Press Stop or the left arrow to go back to the File Menu.  

  

Clear                                   File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 
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Delete a File 
Press the right arrow when “Delete” is highlighted on the display to get the unit into the File > 

Delete Menu. This mode will erase a file (and filename) completely from the SD card. In this mode, 

the top line of the display reads “Delete” on the top left line and “File” on the right. Below this, the 

filename is listed on the left and the file size is listed on the right.   

Delete                                  File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 

 

 To delete a file, use the up or down arrow keys to select a file.    

 Once a file is selected to be deleted, press the right arrow key to delete the file.   

 Press Enter to confirm. Or, to escape without deleting the file, press the left arrow or Stop 

key. 

 The display will indicate “Done!” when the file is erased.  

 Press Stop or the left arrow to go back to the File Menu.  

 

Create a File 
Press the right arrow when “Create” is highlighted on the display to get the unit into the File > 

Create Menu. The top line of the screen will read “Name” on the left, and a file name (e.g. “file00”) 

on the right.  

 

Name:                               file00 

ENTER TO CREATE A FILE 

STOP TO CANCEL 

 NOTE:  The Stop key can be pressed at any time to abort the file creation process and to 
return to this point. 

 
Pressing the arrow keys will allow the user to enter an alpha or numeric selection for a six-

character file name. The right/left arrow keys select which character in the file name to edit and the 

up/down arrow keys are used to choose a character.  
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The chart lists the available characters. Although special characters are seen as options while 

creating a filename, it is currently recommended not to use special characters when naming files. 

The filename must end in a number, or else the file will be corrupt and no data will be saved to it.  

 

 

 

 

Pressing the Save key in the "Create" mode saves the file. Should the file name be identical to 

another file name, the instrument will display the message “duplicate name” on the top line of the 

display and “enter” on the bottom.    

 

 

 

The F-900 will save all parameters for each measurement on the SD card. Once finished creating the 

file name, press the Enter key, or press Stop to abort the process. The F-900 will exit to the File 

Menu.  

 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z  

a b c d e f g h i j k l m n o p q r s t u v w x y z  

0 1 2 3 4 5 6 7 8 9 

Fruit01                           Create 

<enter>                          <stop> 
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Open File 
Press the right arrow when “Open” is highlighted on the display to get the unit into the File > Open 

Menu. The top line of the screen will read “Open” on the left, and “File” on the right. Filenames are 

listed on the left and the file size is listed in the right column.  

The default file on the instrument is File01. Data will be saved into File01 unless another file is 

created and opened. Data can be appended to the end of a file, so files that were previously used can 

be re-opened.  

Open                                     File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 

Fruit9                                       -2 

 

An empty file will have a zero as the file size. If the file is corrupt, the file size will be a negative 

number. Any file with a negative file size should be deleted and re-created. Only files with positive 

numbers or a zero for the file size can be opened to save data too.  

 Use the up or down keys to select the file to open.  

 Press the right arrow to open the file. “Done!” will flash across the screen if the file was 

opened successfully.  

 Press Stop or the left arrow to go back to the File Menu.  

 Moving the cursor to another file after opening a file and then exiting the menu by pressing 

either Stop or the left arrow opens the second file (the last file highlighted on the menu is 

opened). 

 Note: After a file is created, it must be opened in order to start saving data to it.  
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Data Transfer to a Computer  
To view the collected data on a computer, remove the SD card and insert it in an SD card reader on 

the computer. Or, use the supplied USB cable and connect the instrument to the USB host 

(computer). The user can only view/manipulate data on a computer via the USB connection, or with 

the removable SD card. Data cannot be viewed after it is saved on the F-900. 

Once the instrument is connected to the computer via USB cable, it is strongly recommended that 

the user copy and re-save the files and images to the hard drive of the computer. The computer 

application used to view the files can also be used to re-save them. It is recommended that the user 

does not work from the original file on the SD card after the measurement has been made, because 

if any changes are made to the original file, it can break the alignment of the file causing error and 

data loss. 

In order to keep the file system in sync, perform any editing or further calculations on the copied 

file saved to the computer hard drive. Do not edit the files directly on the SD card! 

Do not connect the USB cable to the instrument and the computer while performing measurements. 

If the user tries to operate the instrument through the computer, the files are subject to becoming 

out of sync, breaking alignment and causing errors in the files. This can also lead to problems with 

saving data. 

If an error occurs in a specific data file, it can be deleted and created again. Go to the File Menu on 

the instrument; clear the file where the error has occurred. If the file has been transferred to the 

computer, delete it on the computer also. Once the corrupted files have been deleted, create the file 

again (if it has been properly cleared, the same file name can be used) and re-take the 

measurement.  
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Data Files  

Open the data files saved on the SD card on the computer using Microsoft Excel or Notepad. The 

figure below is an example data spreadsheet. Data values included are the date and time of the 

measurement, the ethylene level in ppm, the mode (monitor, measure or cleaning, offset or GC 

emulation), the CO2 and O2 concentration, the temperature of the gas stream in degrees Celsius, the 

relative humidity (RH) of the gas stream in percent, the atmospheric pressure (KPa) and the flow 

rate of the gas stream in ml/min. In this example, when the CO2 or O2 sensors are not being used, 

the concentration values are zero. For the mode, monitor indicates measurements without 

PolarCept, sm_measure or sm_clean indicate PolarCept, and offset indicates zero calibration.   

 
Figure 23: Example data spreadsheet for a F-900 measurement.  
 

REMEMBER: Always save the data files to the computer before making changes or starting analysis.  
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Below is an example of ethylene data plotted for PolarCept, that shows the typical peaks and valleys 

for the measure/cleaning cycle. At the end of the cleaning time, the ethylene level should be low 

(below 0.2 ppm). If a low ethylene concentration is not seen at the end of the cleaning period, 

lengthen the Cleaning period in Setup > Chamber > Chamber In = Special and test again.  

 
 

Figure 24: Example of ethylene data graphed showing peaks/valleys for measure and 
cleaning periods.    
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Firmware Update 
Transfer all data files from the SD card and DELETE all data files on SD card before doing the 

firmware update! Leaving data files from older firmware versions may corrupt the SD card. 

Several files should be accessed from the software CD or downloaded from the F-900 software 

webpage (http://felixinstruments.com/support/f-900-support/software). Always double-check 

the webpage for the latest compatible firmware version depending on the serial number of the F-

900. Please contact Felix Instruments technical support with questions about firmware updates. 

 Setup application: F-900_Package_Setup_v1.0.exe  

 Firmware code file: F-900-ver-x.xx.bin (Example: F-900-ver-4.6.1.bin) 

F-900 Driver Installation Procedure 

1. Connect the F-900 to the computer using the mini-USB to USB cable.  

2. Launch F-900_Package_Setup_v1.0.exe  

3. Set up device as prompted message below 

 

4. The F-900 requires an libusb driver. In the Zadig window, select Options > List All Devices.  

 

  

http://felixinstruments.com/support/f-900-support/software
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5. In the dropdown list, select CI-DFU (Interface 1) device. 

 

6. At the spinner list (green arrow), select libusb-win32. 

 

7. Click Install Driver to proceed installing libusb driver. This could take up to 1 minute to 

complete. 

Note: Wait for Windows “obtaining driver” process to complete before clicking Install driver.  
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8. When the device drivers and software package installation is done, in the Windows Start 

menu, there will be shortcuts for F-900 Controller and F-900 Firmware Upgrade.  

 

 

 

F-900 Firmware Update Procedure 

1. After installing the driver, open the F-900 Firmware 

Upgrade application: “Transfer Code to CI-203 or CI-

900.” 

2. If device is on, press the Power button to power off the 

device. Hold the down arrow button, then press the 

Power button. The device's internal green LED near the 

USB port/SD card should start flashing quickly. The 

device must be unplugged for this to work.  

3. After the green LED is flashing quickly, connect the device 

to the PC with USB cable.  

4.  Select File and Open in the F-900 Firmware Upgrade 

program. 

5. Navigate to where the F-900-ver-x.xx.bin is saved on the 

PC hard drive. This is the code for the instrument.  

6. Follow the instructions in the software to hold down the Power button.  

7. Release the Power button when instructed. 

8. Wait for the flash to be erased and then written. When the firmware transfer is complete, 

the software will indicate reset sent, followed by “leaving open”. The F-900 will power off. 



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 73 
sales@felixinstruments.com                                         www.felixinstruments.com 

9. Power on the F-900 and check the firmware version at 

the top of the display. The Transfer Code software 

application will indicate that no instrument is found, if 

the F-900: 

A. is not connected to the computer 

o verify USB connection and LED is flashing  

B. is not powered on 

o verify on device display 

C. driver is not properly installed  

o install or re-install F-900 driver 

 

If the F-900 becomes unresponsive or frozen during the firmware update, especially when using 

Windows 8, please try the following: 

1. Hold the power button for 10 seconds and let go. 

2. Hold the down arrow button then press power button, device's internal green LED near USB 

port/SD card should start flashing quickly 

3. Connect the device to computer via USB and repeat the download firmware procedure. 

 

After the firmware update is successful, it is recommended to let the F-900 measure with the 

Closed Loop On (Measure > Settings) for 12 hours. 

  



F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 74 
sales@felixinstruments.com                                         www.felixinstruments.com 

Cleaning and Maintenance 
The F-900 housing can be wiped down with a damp cloth if the unit becomes dirty or dusty. Please 

make sure to always keep the IN and OUT ports on the front panel clear from any obstructions.  

The water in the electrochemical cell of the unit needs to be replenished periodically using distilled 

water. The exact hours of use before this will depend on the humidity and temperature of the 

environment the F-900 is typically used in. Warm or low humidity/dry environments will required 

more frequent refills. Please contact support@felixinstruments.com for more information or to 

schedule instrument servicing.  

 

Maintaining the Electrochemical Sensor 
The liquid reservoir must contain a sufficient amount of electrolyte at all times. The electrocatalytic 

sensor operates utilizing water and therefore requires replenishment of the electrolyte solution (1 

ml/day while operating using Monitor Mode). Depending on the mode of operation and the 

environment in which it is used, the sensor cell may need to be replenished with distilled water 

every 2-3 weeks if Chamber In is not set to ON and filled with distilled water. The electrolyte level 

should be monitored on regular basis and prior to operation for an extended period of time. The 

analyzer will arrive filled with the proper electrolyte. The refill or replenishment of the sensor is 

almost fully automated and uses PolarCept.  

Only replenish with distilled water. Refilling is needed on a regular basis if the unit is being run 

with dry gas and Chamber In is not on and filled with water. If Chamber In is run continuously with 

distilled water, the level of water in the sensor should not change very much and the levels need 

only be checked every 6 months.  

Check the sensor every 2-3 weeks if run continuously in very dry environments (<20% RH). It is 

recommended to refill the sensor before the liquid level drops 10 ml. How often the reservoir needs 

to be refilled will depend on the conditions the instrument is used in (temperature, relative 

humidity).  

Note: A dry gas being fed into the F-900 at 25 0C will cause an expected water loss of 0.1 ml/hr; at 30 0 C a dry 

gas will cause a loss of 0.3 ml/hr. Expected water loss can be up to 3 ml/day when feeding dry gas through 

the F-900.  

mailto:support@felixinstruments.com
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 Use Chamber In to Replenish the Sensor (RECOMMENDED):  

Chamber In in Special mode with distilled water, can be used to help keep the electrochemical cell 

hydrated and avoid having to refill the sensor manually with a syringe.  

1. Fill Chamber In to the fill-line located on the back of unit using fresh distilled water. 
2. Fill Chamber Out with potassium permanganate. 
3. Start a measurement and right arrow to get to the Settings Menu. Set the following: 

a. Chamber In = On 
b. Chamber Out = On 
c. Closed Loop = On 

4. Allow the unit to run with these settings for several hours or until the unit has returned 
to the overall sensor full weight  

5. Details about the electrochemical cell status can be found in the Setup>Sensor>Cell 
Hydration menu. 

 

Note: The refill dead time is proportional to the R.H. of the measured gas and the duration of 

measurement. For example: dry gas at <10% R.H. will have ~1:1 measurement to dead time. Room 

air at 25-30% R.H. will have ~1:2 ratio. Any unit that measures ~40% R.H. should, in theory, never 

dry out. 

 
Note: Weighing the entire F-900 unit on an analytical balance when the sensor is full will allow you 

to monitor the water level of the sensor, by keeping track of the weight loss of the whole F-900 unit. 

Remember to always weigh the F-900 with the same setup and to follow the instructions above to 

remove and refill the sensor, when it has lost 20-25 grams of water. The weight of the instrument 

completely assembled with a full sensor is found in the Production Test Check Sheet.  
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Technical Support 
If you have a question about the F-900, first look in the F-900 Operation Manual. There is also 

online support available for the F-900 at http://felixinstruments.com/support/f-900-support. If 

you cannot find the answer, you can contact a Technical Support Representative located in your 

country. Felix Instruments is committed to providing customers with high quality, timely technical 

support. Technical support representatives are there to answer your technical questions by phone 

or by e-mail at support@felixinstruments.com.  

 

Felix Instruments contact information:  

 
Felix Instruments-Applied Food Science. 

1554 NE 3rd Ave 
Camas, WA 98607 USA 

 
Phone: 800-767-0119 (U.S. and Canada) 

360-833-8835 
Fax: 360-833-1914 

 
Internet: http://www.felixinstruments.com 

E-mail: support@felixinstruments.com 
 

Customer Service 
Customer Service Representatives answer questions about specifications and pricing, and sell all of 

the Felix Instruments products. Customers sometimes find that they need Felix Instruments to 

upgrade, recalibrate or repair their system. In order for Felix Instruments to offer these services, 

the customer must first contact us and obtain a Return Merchandise Authorization (RMA) number. 

Please contact a customer service representative for specific instructions when returning a product. 

http://felixinstruments.com/support/f-900-support
mailto:support@felixinstruments.com
mailto:support@felixinstruments.com
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Frequently Asked Questions 
If there are any questions about the F-900, please check the Frequently Asked Questions below, as 

well as the Felix Instruments support webpage at http://felixinstruments.com/support/f-900-

support.  

1. What type of fruit produces ethylene? 

a. Climacteric fruits refer to fruits that have high respiration rate during the fruit's 

ripening. During the ripening process of climacteric fruits, the production of a 

phytohormone, ethylene, dramatically increases up to 1000-fold of the basal 

ethylene level. Climacteric fruits are ones that are able to ripen after being 

picked. An example of climacteric fruit is bananas; they are picked and shipped 

green and then ripen at a later time (often in the store or home). Climacteric 

fruits include, but are not limited to, apples, apricots, avocados, bananas, 

cantaloupes, figs, guavas, kiwis, mangoes, nectarines, peaches, pears, 

persimmons, plums, and tomatoes. [Source: Wikipedia.com] 

2. What should I do if I see moisture develop in the tubing when monitoring a fruit in the 

chamber? 

a. There is a protective hydrophobic filter inside the IN port on the front of the F-

900. This will prevent moisture from fully entering the instrument. Silica gel in a 

conditioning chamber can be used to dry out the gas stream, either before or 

after the gas passes the electrochemical sensor. Refer to the flow path diagram 

in the Setup>Chamber section of the User Manual for more information.  

3. Can the data output be directly linked to the computer, and by what type of connection 

can be used? And is it MAC and/or PC compatible? 

a. The unit has an SD card and the format can be read on any Mac or PC. Data can 

also be downloaded via USB. The F-900 Controller software is used when 

connecting to a PC to view real-time data (see page 32 for more details.) 

4. How do I change how the data appears in the .csv file? 

a. If data isn't displaying properly, try saving the file as a .csv file type and re-

opening it. If saving as a .csv does not fix how the data is displayed, you may 

need to change the separator value on your computer.  

To change the separator in all .csv text files: 

1. In Microsoft Windows, click the Start button, and then click Control Panel. 

2. Open the Region and Language Options dialog box. 

3. Do one of the following: 

http://felixinstruments.com/support/f-900-support
http://felixinstruments.com/support/f-900-support


F-900 Instruction Manual 10/30/2015 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 78 
sales@felixinstruments.com                                         www.felixinstruments.com 

a. In Windows Vista and 7, click the Formats tab, and then click 

Customize this format. In Windows 7 click the "additional settings" 

button to get to the option to change the separator. 

b. In Windows XP, click the Regional Options tab, and then click 

Customize. 

4. Type a new separator in the List separator box. For example, type "," 

5. Click OK twice. 

NOTE: After you change the list separator character for your computer, all programs 

use the new character as a list separator. You can change the character back to the 

default character by following the same procedure. 

5. How do I create and open a file to start using the F-900? 

a. To start using the F-900, create a file to save data into. Go to File>Create. Change 

the file00 to the desired file-name and press save. Next, open the file to save 

measurements. Go to File>Open and use the arrows to highlight the newly 

created file. If the value next to the file-name is a negative number, this indicates 

an error. You should delete the file and create it again. Then, open it and check 

that the value is zero. Now, you can save data into this file. 

6. What consumables come with the F-900? 

a. The F-900 and F-900RK ship with potassium permanganate (KMnO4), an 

ethylene scrubber (Purafil Fresh Air Sachets). KMnO4 is sold at many Home and 

Garden stores and online. The pellet (vs. crystal or powder) form of KMnO4 is 

recommended. 

i. http://www.producefreshies.com/ 

ii. http://www.water-softeners-filters.com/potassium-permanganate-free-

flowing-2-

lbs.php?gclid=CjwKEAjwqamhBRDeyKKuuYztxwQSJAA1luvG99Od7hn1

UO9syxQjxnCTkdfFe22M_bttL-t8qgs7QhoC2Kfw_wcB 

 

b. The F-900RK also ships with a humidity scrubber (silica gel). If the F-900 

includes an optional CO2 sensor, soda lime is provided as a CO2 scrubber. 

Carolina Biological (www.carolina.com) is an online source for soda lime and 

silica gel.  

  

http://www.producefreshies.com/
http://www.water-softeners-filters.com/potassium-permanganate-free-flowing-2-lbs.php?gclid=CjwKEAjwqamhBRDeyKKuuYztxwQSJAA1luvG99Od7hn1UO9syxQjxnCTkdfFe22M_bttL-t8qgs7QhoC2Kfw_wcB
http://www.water-softeners-filters.com/potassium-permanganate-free-flowing-2-lbs.php?gclid=CjwKEAjwqamhBRDeyKKuuYztxwQSJAA1luvG99Od7hn1UO9syxQjxnCTkdfFe22M_bttL-t8qgs7QhoC2Kfw_wcB
http://www.water-softeners-filters.com/potassium-permanganate-free-flowing-2-lbs.php?gclid=CjwKEAjwqamhBRDeyKKuuYztxwQSJAA1luvG99Od7hn1UO9syxQjxnCTkdfFe22M_bttL-t8qgs7QhoC2Kfw_wcB
http://www.water-softeners-filters.com/potassium-permanganate-free-flowing-2-lbs.php?gclid=CjwKEAjwqamhBRDeyKKuuYztxwQSJAA1luvG99Od7hn1UO9syxQjxnCTkdfFe22M_bttL-t8qgs7QhoC2Kfw_wcB
http://www.carolina.com/
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7. What are some possible applications for the F-900? 

a. The F-900 could be used to help optimize Controlled Atmosphere Storage 

Rooms and prevent losses. Ethylene is an important and sensitive marker for 

ripening of fruits. Other postharvest research applications are possible. 

b. In addition to plants, some microorganisms, including fungi and bacteria, 

synthesize ethylene. Microorganisms can cause great losses in the postharvest 

industry through disease and mold, so research into ethylene and the pathogen-

host interaction is important. A common plant pathogen that produces ethylene 

is Botrytis cinerea. 

c. Measuring ethylene concentration in the air of rooms where young apple trees 

in pots are stored adjacent to refrigerated apple storage rooms, in order to 

assess the safety to young apple trees. During the winter months, the safe level 

for storage of first year apple trees is below 50ppm. 

d. Commercial apple growers could monitor the ethylene levels of empty 

refrigerated rooms before storing bare-root nursery trees. Rooms should be 

empty of ethylene before storing nursery trees and often growers have no way 

to monitor this.  

e. Monitoring ethylene emission from industrial sources. Ethylene is of interest 

because it plays a role in atmospheric ozone chemistry. This will be dependent 

on interfering gas and the source of industrial emissions. 

8. How long does it take to recharge the battery? 

a. About four hours. The unit may be operated while the battery is charging. 

9. What happens if the cell runs out of water? 

a. If the cell runs out of water, the lead electrode could undergo sulfation. This 

would affect the sensitivity by reducing the active area on the lead electrodes. It 

is more likely that a lack of water in the cell decreases the activity of the 

electrolyte and increases the resistivity of the Nafion membrane. Both will affect 

the background current and response time of the cell. 

10. What are the advantages of the F-900RK over the standard F-900?  

a. Both are portable, but the research kit includes the other components as listed 

in the “Unpacking the F-900” section of the User Manual, such as the fruit 

chamber and wand and hard-sided, wheeled carrying case. The Research Kit is 

designed to make measurement of fruits non-destructively or in a closed 

chamber. Fans are built into the fruit chamber to mix the air.  
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11. What are the most commons uses for Chamber In and Chamber Out? 

a. Both chambers are optional, but it is recommended to use Chamber In as 

PolarCept for most measurements. The most common use for Chamber In is to 

separate light hydrocarbons, such as alcohol, from the gas stream which may 

interfere with the measurement. The most common use for Chamber Out is to be 

filled with potassium permanganate, so that it cleans all ethylene and other 

hydrocarbons from the gas stream, so that any ethylene that is measured must 

have come from the sample. Chamber Out is also commonly used with KMnO4 to 

calibrate the zero of the ethylene sensors.  

12. During a monitoring experiment, will the sealed fruit chamber influence the result as 

time goes on?  

a. The air should be scrubbed by enabling conditioning Chamber Out (filled with 

potassium permanganate). Attach the tubing from the wand that returns to the 

fruit chamber to the Out port on the front of the F-900.  

13. How is Chamber In used to rehydrate the electrochemical cell? 

a. The electrochemical sensor can be rehydrated by putting distilled water in 

Chamber In. If water is being used in Chamber In for separating out alcohols, 

then refilling of the sensor will never be necessary. Similarly, if the sensor is 

used in a humid environment, the sensor will not dry out.  

14. Where are temperature and humidity measured? 

a. The temperature and relative humidity sensors are located inside the F-900, 

before the electrochemical sensor. There is an additional relative humidity 

sensor after the ethylene sensor to help track water loss. 

15. What type of membrane does the electrochemical sensor have? 

a. The electrochemical sensor uses a nafion or nafion-like membrane.  

16. What is the emission rate of ethylene from the fruit, taking into account the weight of 

the fruit (or sample) and the time measured? 

a. Flow rate: 0.2L/min = 12.0L/hr 

Sensitivity of C2H4 PPM sensor to C2H4: 0.1 µL/L or 100 nL/L 

Therefore, the F-900 optimally detects around 1200 nL/hr. If the specimen 

weighs 50 grams, then the emission rate is: 24 nL C2H4/gfw/h. The unit is 

nanoliters of ethylene per gram fresh weight per hour.  
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17. What types of tubing materials have been found to outgas? 

a. Several types of material have been found to outgas interfering gases of the 
ethylene sensor, such as Tygon. Viton and Teflon have successfully been found 
to not outgas.  
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FELIX INSTRUMENTS HARDWARE WARRANTY 
 

Important: Please Read! 
 
Seller’s Warranty and Liability: Seller warrants new equipment of its own manufacturing against 
defective workmanship and materials for a period of one year, of a single shift operation, from date 
of receipt of equipment - the results of ordinary wear and tear, neglect, misuse, accident and 
excessive deterioration due to corrosion from any cause is not to be considered a defect. Any 
defect must be called to the attention of Felix Instruments, Camas, Washington, USA, in writing, 
within 90 days after receipt of the unit. 
 
Seller’s liability for defective parts is limited to the repair or replacement of any part of the 
instrument without charge, if Felix Instruments’ examination discloses that part to have been 
defective in material or workmanship, and in no event shall exceed the furnishing of replacement 
parts F.O.B. the factory where originally manufactured. No equipment may be repaired or altered 
by anyone not authorized by Felix Instruments. 
 
Material and equipment covered hereby, which is not manufactured by Seller, is to be covered only 
by the warranty of its manufacturer. Seller shall not be liable to the Buyer for loss, damage, or 
injury to persons (including death), or to property or things, whatsoever, including, but without 
limitation, products processed by the use of the equipment; or for damages of any kind or nature 
(including, but without limitation, loss of anticipated profits), occasioned by or arising out of 
installation, operation, use, misuse, nonuse, repair, or replacement of said material and equipment, 
or out of the use of any method or process for which the same may be employed. The purchaser is 
to pack, ship, or deliver the instrument to Felix Instruments, in Camas, Washington, USA, within 30 
days after Felix Instruments has received written notice of the defect at the customer’s expense. No 
other arrangements may be made unless otherwise approved in writing by Felix Instruments. 
 
The use of this equipment constitutes Buyer’s acceptance of the terms set forth in this warranty. 
There are no understandings, representations, or warranties of any kind, express, implied, 
statutory, or otherwise (including, but without limitation, the implied warranties of 
merchantability and fitness for a particular purpose), not expressly set forth herein. 
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APPENDIX I: Material Safety Data Sheet for 2N Sulfuric Acid 

Solution 

SECTION 1: CHEMICAL PRODUCT AND COMPANY IDENTIFICATION 
Product Name: Sulfuric Acid, 2N 
Catalog Codes:  
CAS#: Mixture. 
RTECS: Not applicable. 
TSCA: TSCA 8(b) inventory: Sulfuric acid; Water  
CI#: Not applicable. 
Synonym: 
Chemical Name: Not applicable. 
Chemical Formula: Not applicable. 
 
Contact Information: 

Felix Instruments-Applied Food Science 
1554 NE 3rd Ave 
Camas, WA 98607 USA 
Phone: 1-800-767-0119  
(U.S. and Canada): 1-360-833-8835 

 
CHEMTREC (24HR Emergency Telephone), call: 1-800-424-9300 
International CHEMTREC, call: 1-703-527-3887 
For non-emergency assistance, call: 1-281-441-4400 

 

SECTION 2: COMPOSTION AND INFORMATION ON INGREDIENTS 
Composition: 

Name CAS # % by Weight 

Sulfuric acid 7664-93-9 9.8 

Water 7732-18-5 90.2 

 
Toxicological Data on Ingredients: Sulfuric acid: ORAL (LD50): Acute: 2140 mg/kg [Rat.]. VAPOR (LC50): Acute: 255 ppm 4 
hour(s) [Rat.]. 

SECTION 3: HAZARDS IDENTIFICATION 
Potential Acute Health Effects: 
Extremely hazardous in case of skin contact (corrosive, irritant), of eye contact (irritant), of ingestion, of inhalation. Liquid or 
spray mist may produce tissue damage particularly on mucous membranes of eyes, mouth and respiratory tract. Skin contact 
may produce burns. Inhalation of the spray mist may produce severe irritation of respiratory tract, characterized by coughing, 
choking, or shortness of breath. Inflammation of the eye is characterized by redness, watering, and itching. Skin inflammation is 
characterized by itching, scaling, reddening, or, occasionally, blistering. 
 
Potential Chronic Health Effects: 
Extremely hazardous in case of skin contact (corrosive, irritant), of eye contact (irritant), of ingestion, of inhalation. 
Nonsensitizer for skin. Non-permeator by skin. CARCINOGENIC EFFECTS: Not available. MUTAGENIC EFFECTS: Not available. 
TERATOGENIC EFFECTS: Not available. DEVELOPMENTAL TOXICITY: Not available. The substance is toxic to lungs, mucous 
membranes. Repeated or prolonged exposure to the substance can produce target organs damage. Repeated or prolonged 
contact with spray mist may produce chronic eye irritation and severe skin irritation. Repeated or prolonged exposure to spray 
mist may produce respiratory tract irritation leading to frequent attacks of bronchial infection. Repeated or prolonged 
inhalation of vapors may lead to chronic respiratory irritation. 
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SECTION 4: FIRST AID MEASURES 
Eye Contact: 
Check for and remove any contact lenses. Immediately flush eyes with running water for at least 15 minutes, keeping eyelids 
open. Cold water may be used. Do not use an eye ointment. Seek medical attention. 
 
Skin Contact: 
If the chemical got onto the clothed portion of the body, remove the contaminated clothes as quickly as possible, protecting 
your own hands and body. Place the victim under a deluge shower. If the chemical got on the victim's exposed skin, such as the 
hands: Gently and thoroughly wash the contaminated skin with running water and non-abrasive soap. Be particularly careful to 
clean folds, crevices, creases and groin. Cold water may be used. If irritation persists, seek medical attention. Wash 
contaminated clothing before reusing. 
 
Serious Skin Contact: 
Wash with a disinfectant soap and cover the contaminated skin with an anti-bacterial cream. Seek medical attention. 
Inhalation:  
Allow the victim to rest in a well ventilated area. Seek immediate medical attention. 
 
Serious Inhalation: 
Evacuate the victim to a safe area as soon as possible. Loosen tight clothing such as a collar, tie, belt or waistband. If breathing 
is difficult, administer oxygen. If the victim is not breathing, perform mouth-to-mouth resuscitation. WARNING: It may be 
hazardous to the person providing aid to give mouth-to-mouth resuscitation when the inhaled material is toxic, infectious or 
corrosive. Seek immediate medical attention. 
 
Ingestion: 
Do not induce vomiting. Loosen tight clothing such as a collar, tie, belt or waistband. If the victim is not breathing, perform 
mouth-to-mouth resuscitation. Seek immediate medical attention. 
Serious Ingestion: Not available. 

SECTION 5: FIRE AND EXPLOSION DATA 
Flammability of the Product: Non-flammable. 
Auto-Ignition Temperature: Not applicable. 
Flash Points: Not applicable. 
Flammable Limits: Not applicable. 
Products of Combustion: Not available. 
Fire Hazards in Presence of Various Substances: Not applicable. 
Explosion Hazards in Presence of Various Substances: 
Risks of explosion of the product in presence of mechanical impact: Not available.  
Risks of explosion of the product in presence of static discharge: Not available. 
Fire Fighting Media and Instructions: Not applicable. 
Special Remarks on Fire Hazards: Not available. 
Special Remarks on Explosion Hazards: Not available. 

SECTION 6: ACCIDENTAL RELEASE MEASURES 
Small Spill:  
Dilute with water and mop up, or absorb with an inert dry material and place in an appropriate waste disposal container. If 
necessary: Neutralize the residue with a dilute solution of sodium carbonate. 
 
Large Spill: 
Corrosive liquid. Stop leak if without risk. Absorb with DRY earth, sand or other non-combustible material. Do not get water 
inside container. Do not touch spilled material. Use water spray curtain to divert vapor drift. Prevent entry into sewers, 
basements or confined areas; dike if needed. Call for assistance on disposal. Neutralize the residue with a dilute solution of 
sodium carbonate. Be careful that the product is not present at a concentration level above TLV. Check TLV on the MSDS and 
with local authorities. 
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SECTION 7: HANDLING AND STORAGE 
Precautions: 
Keep container dry. Do not breathe gas/fumes/ vapor/spray. Never add water to this product In case of insufficient ventilation, 
wear suitable respiratory equipment If ingested, seek medical advice immediately and show the container or the label. Avoid 
contact with skin and eyes Keep away from incompatibles such as alkalis. May corrode metallic surfaces. Store in a metallic or 
coated fiberboard drum using a strong polyethylene inner package. 
 
Storage: 
May corrode metallic surfaces. Store in a metallic or coated fiberboard drum using a strong polyethylene inner package. 
Corrosive materials should be stored in a separate safety storage cabinet or room. 
 

SECTION 8: EXPOSURE CONTROLS/PERSONAL PROTECTION 
Engineering Controls: 
Provide exhaust ventilation or other engineering controls to keep the airborne concentrations of vapors below their respective 
threshold limit value. 
 
Personal Protection: 
Face shield. Full suit. Vapor respirator. Be sure to use an approved/certified respirator or equivalent. Gloves. Boots. 
 
Personal Protection in Case of a Large Spill: 
Splash goggles. Full suit. Vapor respirator. Boots. Gloves. A self-contained breathing apparatus should be used to avoid 
inhalation of the product. Suggested protective clothing might not be sufficient; consult a specialist BEFORE handling this 
product.  
 
Exposure Limits: 
Sulfuric acid TWA: 1 STEL: 3 (mg/m3) from ACGIH Consult local authorities for acceptable exposure limits. 

 

SECTION 9: PHYSICAL AND CHEMICAL PROPERTIES 

Physical state and appearance: Liquid. 
Odor: Odorless. 
Taste: Not available. 
Molecular Weight: Not applicable. 
Color: Clear Colorless. 
pH (1% soln/water): 2 [Acidic.] 
Boiling Point: The lowest known value is 100°C (212°F) (Water). 
Melting Point: Not available. 
Critical Temperature: Not available. 
Specific Gravity: The only known value is 1 (Water = 1) (Water). 
Vapor Pressure: The highest known value is 17.535 mm of Hg (@ 20°C) (Water). 
Vapor Density: The highest known value is 0.62 (Air = 1) (Water). 
Volatility: Not available. 
Odor Threshold: Not available. 
Water/Oil Dist. Coefficient.: The product is much more soluble in water. 
Ionicity (in Water): Not available. 
Dispersion Properties: See solubility in water. 
Solubility: Easily soluble in cold water, hot water. Insoluble in methanol, diethyl ether, n-octanol. 

SECTION 10: STABILITY AND REACTIVITY DATA 
Stability: The product is stable. 
Instability Temperature: Not available. 
Conditions of Instability: Not available. 
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Incompatibility with various substances: 
Extremely reactive or incompatible with alkalis. Slightly reactive to reactive with metals. 
 
Corrosivity: 
Extremely corrosive in presence of aluminum, of zinc. Highly corrosive in presence of steel, of copper. Slightly corrosive to 
corrosive in presence of stainless steel(304), of stainless steel(316). Non-corrosive in presence of glass. 
 
Special Remarks on Reactivity:  
Reacts violently with water especially when water is added to the product. (Sulfuric acid) 
 
Special Remarks on Corrosivity: Not available. 
Polymerization: No. 

SECTION 11: TOXICOLOGICAL INFORMATION 
Routes of Entry: Eye contact. Inhalation. Ingestion. 
Toxicity to Animals: LD50: Not available. LC50: Not available. 
 
Chronic Effects on Humans: The substance is toxic to lungs, mucous membranes. 
Other Toxic Effects on Humans: Extremely hazardous in case of skin contact (corrosive, irritant), of ingestion, of inhalation. 
 
Special Remarks on Toxicity to Animals: Not available. 
Special Remarks on Chronic Effects on Humans: Not available. 
Special Remarks on other Toxic Effects on Humans: Not available. 

 

SECTION 12: ECOLOGICAL INFORMATION 
Ecotoxicity: Not available. 
BOD5 and COD: Not available. 
 
Products of Biodegradation: 
Possibly hazardous short term degradation products are not likely. However, long term degradation products may arise. 
 
Toxicity of the Products of Biodegradation: The products of degradation are more toxic. 
Special Remarks on the Products of Biodegradation: Not available. 
 

SECTION 13: DISPOSAL CONSIDERATIONS 
Waste Disposal: 

SECTION 14: TRANSPORT INFORMATION 
DOT Classification: CLASS 8: Corrosive liquid. 
Identification: Sulfuric acid, solution: UN2796 PG: II 
Special Provisions for Transport: Not available. 

SECTION 15: OTHER REGULATORY INFORMATION 
Federal and State Regulations: TSCA 8(b) inventory: Sulfuric acid; Water 
 
Other Regulations:  
OSHA: Hazardous by definition of Hazard Communication Standard (29 CFR 1910.1200). 
 
Other Classifications: 
WHMIS (Canada): 
CLASS D-2A: Material causing other toxic effects (VERY TOXIC). CLASS E: Corrosive liquid. 
DSCL (EEC): R35- Causes severe burns. 
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HMIS (U.S.A.): 
Health Hazard: 1 
Fire Hazard: 0 
Reactivity: 0 
Personal Protection: 
National Fire Protection Association (U.S.A.): 
Health: 1 
Flammability: 0 
Reactivity: 0 
Specific hazard: 
Protective Equipment: Gloves. Full suit. Vapor respirator. Be sure to use an approved/certified respirator or equivalent. Wear 
appropriate respirator when ventilation is inadequate. Face shield. 
 

SECTION 16: OTHER INFORMATION 
References: Not available. 
Other Special Considerations: Not available. 
Created: 12/21/2010 
Last Updated: 4/23/2012 
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APPENDIX II: Procedure for F-900 Validation Using Fruit 
The following methods should be run consecutively on a given replicate and repeated for each new 

replicate (new specimen). At least 5 replicates for pre-climacteric (un-gassed or still green) apples, 

bananas, or avocados should be run. The data from method 1 and 2 can be combined into a table. 

The results from method 3 can be graphed, as a figure, to show the trend over time.  

Method 1: Sampling with No Filtration/Trapping 
The purpose of this method is to determine what response the sensor has without trapping of 

interfering gases. This can be thought of as the baseline response  

Procedure:  

1. Turn on the F-900, verify chambers are set to off and flow is set to 200 ml/min.  

2. Connect experimental setup as shown in Figure 25.  

3. Load the sample specimen into the fruit chamber. 

4. Start measuring the fruit headspace with the F-900.  

5. After sampling the headspace for 5 minutes, or a set period of time of your choosing, take a 

syringe sample and run it in the GC (gas chromatograph). Record result in spreadsheet 

program, such as Microsoft Excel.  

6. Vent the fruit chamber, record the result in Microsoft Excel and start Method 2. The fruit 

chamber should be well vented to flush out any plant gases between measurements.  

Method 2: Sampling with Filtration/Trapping  
The purpose of this method is to determine what response the sensor has with trapping of 

interfering gases by H2O. This can be thought of as the effect to the instantaneous measurement.  

Procedure:  

1. Fill conditioning Chamber In with distilled water and clean the water using potassium 

permanganate in an in-line column connected to the intake port of the F-900, until the 

background signal is below 20ppb.  

2. Load the sample specimen into the fruit chamber. 

3. Start measuring the fruit headspace with the F-900.  

4. After sampling the headspace for exactly 5 minutes, take a syringe sample and run it in the 

GC (gas chromatograph). Record result in spreadsheet program, such as Microsoft Excel.  

5. Vent the fruit chamber, record the result in Microsoft Excel and start Method 3.  
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Method 3: Long-Term Monitoring with Filtration  
The purpose of this method is to determine the effectiveness of the PolarCept filter for long term 

measurements. This will require the trap to self-regenerate between consecutive measurements. 

The regeneration time is defaulted to 6 minutes; however for some species a greater time may be 

needed. By keeping the default value for avocados, we can better compare results and will 

demonstrate the weakness of the method and how to realize if the “cleaning” period should be 

extended. 

Procedure:  

1. Fill conditioning Chamber In with distilled water and clean the water using potassium 

permanganate in an in-line column connected to the intake port of the F-900, until the 

background signal is below 40ppb.  

2. Verify that Chamber In is set to “Special” with a sufficient cleaning period for the produce 

being monitored.  

3. Load the sample specimen into the fruit chamber.  

4. Start measuring the fruit headspace with the F-900.  

5. Allow the system to run for 5 measurement and cleaning cycles.  

6. Vent the chamber and load the data file to a computer.  

7. Switch to the next replicate and begin at Method 1 again.  

 

 

 

 

 

Figure 25: Set-up for fruit chamber using (KMnO4) to scrub ethylene from the outside air. 
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APPENDIX III: Guidelines for Measuring Sample Bags 
The following guidelines are for collecting air samples in standard samples bags. In order to collect 

an air sample, you must pump air into the bag (pump not included). These bags are often used to 

collect ambient air samples to analyze later in a laboratory, using a gas chromatograph, or can be 

connected to the F-900 using the accessory parts.  

 Ensure that the bag material and fittings are appropriate for the compounds to be sampled. 

 Use only Teflon or Viton tubing to connect the sample bag to the pump to prevent sample 
loss by adsorption on tubing walls. 

 Before using, flush the bag thoroughly with purified air or nitrogen. 

 Analyze the sample within 24 to 48 hours. Long-term storage of air-contaminant mixtures 
in bags is not recommended. 

 Do not ship sample bags by air unless the cargo cabin is pressurized.  

 Do not overfill sample bags. 

 Secure polypropylene value when opening/closing by holding side stem while turning 
entire upper portion of fitting one revolution. 

 Store bags flat. Do not roll or crease bags during storage. 

 Do not use bags at temperatures above 140 OF (60 OC). 

 Bags are designed for single use only. 

 

To Collect a Sample Using a Sample Bag 

1. Flush the bag at least 3 times with purified air or nitrogen before use. 

2. To fill a bag, connect tubing from the exhaust port of an air sample pump to the hose 
connection on the bag (stem protruding from the side of the fittings). 

3. To open the shut-off valve, hold the side stem and turn the entire upper portion of the 
fitting (including the brown syringe port and the white section to which it is attached) 
counterclockwise one revolution. Turn on the pump and sample. 

4. Avoid filling any bag more than 80% of its maximum volume. 

5. When sampling is complete, turn off the pump. To close the shut-off valve, hold the side 
stem and turn the entire upper portion of the fitting clockwise until it is snug. 

6. To withdraw samples using a needle and syringe, carefully insert the needle into the septum 
port in the center of the brown cap and pierce the septum. Do not allow the needle to 
puncture the bag material when piercing the septum.  

7. Do not use the fitting valve as a handle or hanging device. Although it is durable, it is not 
intended for these uses.  
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Analyzing a Sample Bag with the F-900 

 Connect the sample bag to the IN port of the F-900.  

 Open the sample bag to allow gas to start flowing to the F-900.  

 It takes about 3-5 minutes to measure a sample bag if the concentration of ethylene 

before measuring the sample bag is low. 
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F-900 Production Test Check Sheet 
 

SERIAL NUMBER:  

Firmware Version:  

 

 

SENSOR: Weight (grams): 

C2H4 PPB:  

F-900 fully assembled:  

 

Optional Sensors Included (Yes/No) 

C02 PPM  

CO2 PCT  

O2 PCT  

 

 

CALIBRATION PARAMETERS  C2H4 PPB C2H4 PPM 

Internal offset   

Internal gain   

Calibration RH   

Calibration T   

RH slope   

RH offset  a coef:  

T slope    

T offset   

 

Optional Sensors 
CALIBRATION PARAMETERS  CO2 PPM CO2 PCT 

Zero    

Span   

Calibration T   

 

 

CALIBRATION PARAMETERS  O2 

Internal offset  

Internal gain  

Calibration RH  

Calibration T  

 

Internal Volume (with 

optional sensors) 

 

 

NOTES:                                                                                                                                              
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Warranty Registration Card 

 
1554 NE 3rd Ave, Camas, WA 98607, USA 
Phone: (360) 833-8835  Fax: (360) 833-1914  e-mail: sales@felixinstruments.com Web: www.felixinstruments.com   

PRODUCT REGISTRATION CARD 

Please complete and return this form to Felix Instruments within 30 days to  
validate your Warranty on Parts and Labor. 

     
Registration Information:   

Your Name:____________________________________ Title:__________________ 

Company/University:___________________________________________________ 

Address:_____________________________________________________________  

City:____________________________ State:__________ Zip:__________________ 

Country:__________________________Email_______________________________ 

Phone:______________________________ Fax:____________________________ 

Felix Instruments Serial Number(s):__________________________________________________  

Purchase Date:_____________________  Purchase Price:_____________________   

------------------------------------------------------------------------------------------------------------------ 
FOLD ON DOTTED LINE 

     
Your opinions will help improve our service. Please answer the following questions. 
 
1. What was the basis of your product selection? 
□ Representative Recommendation    □ Price 
□ Product Features      □ Product Design 
□ Technical Specifications     □ Brand Name 
□ Warranty       □ Service 
□ Other _________________________________________ 
 
2.  What other competing brands did you consider? __________________________ 
 
3. Where did you first learn of this product? 
□ Advertisement in ________________________________   □ Representative 
□ Friend/Colleague      □ Exhibit 
□ Other _________________________________________ 
 
4. Who selected this product? 
□ I did       □ Research Group 
□ University Department     □ Purchasing 
□ Other _________________________________________ 
 
5. Comments/Suggestions:  
______________________________________________________________________ 

______________________________________________________________________ 

 
 




